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license booklet is included in your product package, the follow
ingLicense Agreement applies to you. By opening the sealed 
packet(s) containing the software, you indicate your accep
tance of the following Microsoft License Agreement. 
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4. DUAL MEDIA SOFTWARE. If the SOFTWARE package contains both 3.5" and 5.25" disks, then you may use only the disks appropriate for your single-user computer. 
You may not use the other disks on another computer or loan, rent, lease, or transfer them to another user except as part of the permanent transfer (as provided above) of all 
SOFTWARE and written materials. 

5. LANGUAGE SOFTWARE. If the SOFTWARE is a Microsoft language product, then you have a royalty-free right to reproduce and distribute executable files created 
using the SOFTWARE. If the language product is a Basic or COBOL product, then Microsoft grants you a royalty-free right to reproduce and distribute the run-time 
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The "run-time modules" are those files in the SOFTWARE that are identified in the accompanying written materials as required during execution of your software program. 
The run-time modules are limited to run-time files, install files, and ISAM and REBUILD files. If required in the SOFTWARE documentation, you agree to display the 
designated patent notices on the packaging and in the README file of your software product. 

LIMITED WARRANTY 

LIMITED WARRANTY. Microsoft warrants that (a) the SOFTWARE will perform substantially in accordance with the accompanying written materials for a period of 
ninety (90) days from the date of receipt, and (b) any hardware accompanying the SOFTWARE will be free from defects in materials and workmanship under normal use 
and service for a period of one (I) year from the date of receipt. Any implied warranties on the SOFTWARE and hardware are limited to ninety (90) days and one (I) year, 
respectively. Some states/countries do not allow limitations on duration of an implied warranty, so the above limitation may not apply to you. 

CUSTOMER REMEDIES. Microsoft's and its suppliers' entire liability and your exclusive remedy shall be, at Microsoft's option, either (a) return of the price paid, or 
(b) repair or replacement of the SOFTWARE or hardware that does not meet Microsoft's Limited Warranty and which is returned to Microsoft with a copy of your receipt. 
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Welcome to Windows 





Welcome 

Welcome to the Microsoft® Windows ™ operating system, software 
that makes your computer easier and more fun to use. Windows is easy 
to learn because its graphical interface is consistent from one applica
tion to the next. When you've learned to use one application, such as 
Windows Write, you've learned the essentials for using any other 
application with Windows. You can run your existing non-Windows 
applications beside Windows applications and share information 
between them. And now, Windows is easier and faster to set up on 
your system. 

If you are new to Windows, you may want to go to Chapter 3 of this 
book right after setting up Windows. Chapter 3, "A Brief Tour of 
Microsoft Windows," offers a visual introduction to Windows so that 
you can become familiar with the graphical interface before you start 
to use it. 

If you prefer to preview Windows on the screen, you can use the 
Microsoft Windows Tutorial during the Setup program. To use the 
Windows Tutorial, you must have a mouse and a VGA (or better) 
monitor. If Windows is already set up on your computer, you can start 
the Tutorial from within Windows. Choose the Windows Tutorial com
mand from the Help menu in Windows Program Manager. For more 
information, see "Running the Microsoft Windows Tutorial" at the end 
of Chapter 3, "A Brief Tour of Microsoft Windows." 
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About This Book 
Getting Started with Microsoft Windows is a setup guide and introduc
tion to Microsoft Windows version 3.1. 

This book is intended only as an introduction. For complete informa
tion about specific tasks, or for a more in-depth discussion of any 
Windows topic, see the Microsoft Windows User's Guide. 

This book is arranged as follows: 

• "We1come" 

An overview of this book and the other Windows documentation, a 
list of system requirements, and information about registering your 
copy of Windows. 

• Chapter 1, "Setting Up Windows" 

Instructions for setting up Windows, tips for previous Windows 
users on upgrading to Windows version 3.1, instructions for setting 
up Windows using a network, and options for starting Windows 
(for advanced users). 

• Chapter 2, "New in This Version" 

A summary of the new and enhanced features in Windows 
version 3.1. 

• Chapter 3, "A Brief Tour of Microsoft Windows" 

A look at Windows, introducing the basic concepts, some essential 
Windows techniques, and the main applications included with 
Windows. 

• Chapter 4, "Troubleshooting" 

This chapter deals with questions you might have when setting up 
and using Windows, and suggests possible solutions. 
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What You Need to Run Windows 
Windows version 3.1 works with most personal computers available 
today. One of the pieces in your Windows package is a Hardware 
Compatibility List, describing equipment that has passed Windows 
compatibility testing. All hardware on the list, and any hardware that is 
100-percent compatible with hardware on the list, should work with 
Windows version 3.1. If you intend to use hardware that is not on this 
list, ask the equipment manufacturer about any special software you 
might need before you can use the hardware with Windows version 3.1. 

The minimum software and hardware requirements your computer sys
tem needs to run Windows successfully are shown in the following list. 
If you need to verify that your display adapter, mouse, or other hard
ware is supported by Windows, see the Hardware Compatibility List. 

Note The disks in your Windows package are high-density disks. If 
you plan to set up Windows from a low-density drive, you can order 
disks by using the order form at the back of this book. 

Windows requires: 

• Microsoft MS-DOS® version 3.1 or later. (To check your version, 
type ver at the MS-DOS prompt.) 

• For 386 enhanced mode, a personal computer with an 80386 proces
sor (or higher) and 640 kilobytes (K) of conventional memory plus 
1024K of extended memory, 8 megabytes (MB) of free disk space 
(10.0 is recommended), and at least one floppy disk drive. 

For standard mode, a personal computer with an 80286 processor 
(or higher) and 640K of conventional memory plus 256K of 
extended memory, 6.0 MB of free disk space (9 MB is recom
mended), and at least one floppy disk drive. 

Note Minimum disk-space requirements assume no optional com
ponents, network, or printers. Recommended requirements include 
all components installed, including a network and printer. 

• A display adapter that is supported by Windows. 

• A printer that is supported by Windows, if you want to print with 
Windows. 
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• A Hayes, Multi-Tech, Trail Blazer, or compatible modem, if you 
want to use Terminal, the Windows communications application. 

• A mouse that is supported by Windows. Though it is not required, a 
mouse is highly recommended so that you can take full advantage of 
the easy-to-use Windows graphical interface. 

Note To get the best performance from Windows, you should con
figure memory above 640K as extended memory. Memory is discussed 
in Chapter 14, "Optimizing Windows," in the Microsoft Windows 
User's Guide. 

Windows runs in one of two operating modes, standard or 386 en
hanced, depending on your hardware configuration. For information 
about starting Windows in a specific mode, see Chapter 1, "Setting Up 
Windows," in this book. For a definition of each mode, see Chapter 1, 
"Windows Basics," and the Glossary in the Microsoft Windows User's 
Guide. 

Registering Your Copy of Windows 
Please take a moment to fill out and mail the registration card you 
received with Windows. Registering Windows entitles you to the 
following additional benefits: 

• Automatic notification of upgrades or revisions to Windows. By 
receiving timely notices directly from Microsoft, you'll be among 
the first to know about upgrades. 

• Automatic notification when new Windows-related products are re
leased. You'll receive up-to-date information about new Windows 
applications as soon as they become available. 

About Your Windows Documentation 
In addition to this book, the Windows version 3.1 documentation set 
consists of the Microsoft Windows User's Guide, an online Tutorial, an 
extensive online Help system, and several online documents (formatted 
for use with Windows Write) that are copied to your hard disk when 
you set up Windows. 
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The way you like to learn and how much you already know about 
Windows and about computers will determine how you use the differ
ent pieces of the documentation. 

The following list outlines the various pieces of the Windows documen
tation: 

• Getting Started with Microsoft Windows (this book) is a guide to 
setting up Windows on your system, and a brief introduction to 
Windows. 

• The Microsoft Windows User's Guide provides a comprehensive 
description of Windows and the ways you can work with it. It in
cludes explanations and procedures for first-time users, in addition 
to topics for advanced users. 

• The Microsoft Windows Tutorial provides online instructions for 
using a mouse and for performing some basic tasks in Windows. 

• Online Help provides a quick reference to procedures and com
mands you need when using Windows. Context-sensitive Help is 
now available in the main Windows applications-to obtain specific 
information about how to complete a dialog box, just press Fl or 
choose the Help button while using the dialog box. 

• Several online documents are copied to your hard disk when you set 
up Windows. You can read (and print) the files by using Windows 
Write. These files include: 

• SETUP.TXT -Information specific to setting up Windows. Con
tains information about software and hardware configurations that 
require special handling to successfully set up and start Windows. 
(This file can be viewed by using any text editor.) 

• README.WRI-Information updated after the user's guide was 
printed. 

• PRINTERS.WRI-Information about configuring particular print
ers and fonts for the Windows environment. 

• NETWORKS.WRI-Information about operating Windows with 
specific network configurations. 

• SYSINLWRI-Procedures for modifying settings in the 
SYSTEM.INI file (for advanced users only). 

• WININLWRI-Procedures for modifying settings in the 
WIN.INI file (for advanced users only). 
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Conventions 
To help you locate and interpret information easily, Getting Started 
with Microsoft Windows uses consistent visual cues and a few standard 
text formats. These conventions are explained as follows. 

Visual Cues You will find the following typographic conventions 
throughout this guide. 

This 

bold 

italic 

Represents 

Anything that you must type exactly as it appears. 
For example, if you are asked to type dir \windows, 
you would type all the bold characters exactly as 
they are printed. 

Placeholders for information you must provide. For 
example, if you are asked to type filename, you 
would type the actual name for a file instead of the 
word shown in italic type. 

Italic type also signals a new term. An explanation 
immediately follows the italicized term. 

ALL CAPITALS Directory names, filenames, and acronyms. 

Information that is specific to running Windows in 
386 enhanced mode. I~~!l~ 

Keyboard Formats Key combinations and key sequences appear in 
the following formats. 

Format 

KEYl+KEY2 

KEYl, KEY2 

Meaning 

A plus sign (+) between key names means to press and 
hold down the first key while you press the second key. For 
example, "press ALT+ESC" means to press and hold down 
the ALT key and press the ESC key. Then release both keys. 

A comma (,) between key names means to press and release 
the keys one after the other. For example, "press ALT, F" 
means to press and release the ALT key, and then press and 
release the F key. 
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Chapter 1 

Setup Designed with Users in Mind 
Setting up the Microsoft Windows version 3.1 operating system on 
your computer is simple. You can choose between two methods: 
Express Setup and Custom Setup. 

Express Setup 
Express Setup is the method recommended for most users. 

When you use Express Setup, the Setup program identifies your hard
ware and software, configures Windows to run with your system, and 
updates necessary files. All you do is type your name, answer a few 
simple questions (such as what type of printer you have), and insert 
disks when requested. 

If you have applications already on your system, Express Setup sets 
them up so that you can easily use them with Windows. (Setup may be 
unable to set up some less common applications. You can set these up 
later from within Windows. Also, if you want to make changes to your 
system after Windows has been set up, you can do so by running 
Windows Setup from within Windows.) 

Note If your system does not have enough disk space to set up all of 
Windows, Express Setup proposes a partial setup, which excludes some 
or all of the Windows optional components (for example, screen savers 
and additional accessory applications). 
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To set up Windows by using Express Setup, you need to know two 
things: 

• What type of printer you have, if any 

• Which port your printer is connected to 

Note Most computers are equipped with one or more parallel ports, 
such as LPTl, and one or more serial ports, such as COM!. You can 
use these ports to connect your computer to external devices, such as 
a printer. 

A physical port is a socket located on the front or back of your com
puter, into which you plug a mouse, printer, or other hardware. A 
virtual port is an internal connection, defined by the software, such 
as your system connection to a network printer. Your system may 
have one or both types of ports. See your hardware manual for infor
mation about the ports on your system. 

Express Setup sets up Windows in the C:\WINDOWS directory. If you 
are updating from Windows version 3.0, Express Setup asks you for a 
directory name, giving your previous Windows directory as the default 
choice. 

Custom Setup 
Custom Setup is for experienced computer users who want to alter the 
standard Windows configuration. For example, if you want to control 
how your CONFIG.SYS and AUTOEXEC.BAT files are modified, you 
should use this method. 

If you have limited space on your hard disk, you can use Custom Setup 
to choose which optional Windows components (or individual files 
within a component) you want to set up. 

During Custom Setup, you are prompted to verify and provide informa
tion about the following: 

• The directory where you want to store Windows files 

• The type of computer you are using 

• Your display (monitor) type 

• Your mouse, if you are using one 

• Your keyboard and keyboard layout 
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• The language you will work in 

• The network you are on, if any 

• The printer and printer port you use, if any 

• Applications on your hard disk that you want to run with Windows 

• Changes to your AUTOEXEC.BAT and CONFIG.SYS files, if 
necessary 

• Which optional Windows components to install (including the 
Windows Tutorial) 

• Your virtual-memory settings (when running Windows in 386 
enhanced mode) 

Running Setup 
Setup detects minimum system requirements (listed in "Welcome") and 
warns you if your system does not meet the requirements. Also, Setup 
notifies you if it detects system features that are incompatible with 
Setup or Windows. 

Caution Before running Setup, be sure to turn off any automatic 
message service, such as a network popup or a printing notification, 
that prints directly to your screen. These are incompatible with Setup. 

~ To set up Windows 

1. Insert the Windows version 3.1 disk 1 in the drive, and close the 
drive door. 

2. At the MS-DOS prompt, type the drive letter of the drive you're 
using, followed by a colon (:), and then press ENTER. 

For example, the command line might look like this: 

C> a: 

3. Type setup, and then press ENTER. 

4. Follow the instructions on the screen. 

You can choose Express Setup or Custom Setup. It is recommended 
that you use Express Setup; however, you can use Custom Setup if 
you want. Both methods are described earlier in this chapter. 
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Windows Tutorial 
You can choose to go through the brief, online Microsoft Windows 
Tutorial as part of the Setup program. The first Tutorial lesson guides 
you through basic mouse techniques and gives you a chance to practice 
them before you start working with Windows. The second lesson intro
duces you to basic Windows techniques. 

If you choose not to take the Tutorial from within the Setup program, 
you can run it later from within Windows by choosing the Windows 
Tutorial command from the Help menu in Windows Program Manager. 
For complete instructions, see "Running the Microsoft Windows 
Tutorial" at the end of Chapter 3, "A Brief Tour of Microsoft 
Windows." 

Upgrading from Windows Version 3.0 
Although you can keep your existing Windows version 3.0 in a sepa
rate directory, it is strongly recommended that you upgrade your copy 
of Windows version 3.0. You can then take full advantage of the many 
new features and enhancements in Windows version 3.1. First, be sure 
to make backup copies of any data files and programs you have added 
to your system. 

If you have Windows version 3.0, upgrading to Windows version 3.1 
preserves existing Windows settings, such as groups you might have 
created or desktop settings you've chosen. Also, applications, fonts, 
and certain drivers are preserved. Only the Windows system files, 
upgraded device drivers, and accessories are replaced with the new 
versions. 

Upgrading does the following: 

• Maintains existing Program Manager groups 

If you have created new groups in Program Manager or added 
program-item icons to existing groups, Setup preserves those new 
groups or additions. 

• Preserves existing system-information settings 

Upgrading preserves settings for your computer, display (monitor), 
mouse, keyboard and keyboard layout, language, network, and the 
associated drivers. 
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• Updates existing device drivers that were supplied with 
Windows version 3.0 

If you have a Windows version 3.0 driver installed for which there is 
an available updated version, Setup installs the updated driver. 

• Maintains all installed drivers that were not supplied with 
Windows 

If you have a device driver installed that was supplied by another 
manufacturer, Setup leaves the driver unchanged. In some cases, 
Windows version 3.1 has a new driver that you can use in place of 
your existing driver. For example, if you have a Super VGA (video 
graphics adapter), you may want to update to the Windows version 
3.1 Super VGA driver by using Custom Setup or by running Setup 
from within Windows later. 

• Preserves settings relating to the use of your system's upper 
memory area 

The order in which drivers are loaded is critical in optimizing the use 
of the upper memory area. Setup preserves the loadhigh= line and 
its placement in your AUTOEXEC.BAT file. Setup also preserves 
the devicehigh= line in your CONFIG.SYS file. 

Note Although you are strongly advised against it, you can keep 
your existing Windows version 3.0 and add version 3.1 in a separate 
directory. When Setup asks if you want to upgrade, specify a new 
directory for Windows version 3.1. Version 3.1 will not incorporate the 
custom settings you specified for version 3.0, such as new groups, 
colors, and desktop settings. After setting up Windows version 3.1, be 
sure to remove Windows version 3.0 from your PATH setting in your 
AUTOEXEC.BAT file. Some parts of Windows version 3.0 cause seri
ous conflicts if run in Windows version 3.1. 

More Information About Upgrading 
If you are upgrading, please note the following information: 

• If you are using an English version of Windows version 3.1 to 
upgrade a non-English version of Windows version 3.0, Setup will 
upgrade all the necessary Windows device drivers, using the English 
driver names. 

However, some of your installed device drivers that were not origi
nally supplied with Windows may not be upgraded. After setup, you 
may need to obtain new third-party drivers (such as those supplied 
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by hardware manufacturers) and update them by running Setup from 
within Windows or from the MS-DOS prompt. For more informa
tion, see Chapter 15, "Maintaining Windows with Setup," in the 
Microsoft Windows User's Guide. 

• In addition to device drivers supplied with Windows version 3.1, 
Microsoft also provides the Windows Driver Library (WDL), which 
contains device drivers made available after Windows version 3.1 
was released. Device drivers are added to the WDL as they become 
available. If you have a modem, you can download WDL device 
drivers from network services including CompuServe, GEnie, 
Microsoft OnLine, various user-group bulletin-board services 
(BBSs on the APCUG network), and the electronic downloading 
service maintained by Microsoft (phone 206-637-9009). Users who 
do not have a modem may purchase disks by calling Microsoft 
Customer Support Services at 1-800-426-9400. 

Note If your copy of Windows was acquired outside the United 
States, the package contains a subsidiary information card listing 
bulletin-board services (BBSs) from which you can obtain updated 
device drivers. The card also lists local subsidiary telephone num
bers you can call to obtain drivers if no BBS is available or you 
cannot access a BBS. 

Network Setup 
The Setup program has options that can be used to place Windows files 
on a network server or set up Windows for an individual network user 
to run. This section describes both procedures. 

Setting Up Windows over a Network 
If a network system administrator has put the Microsoft Windows files 
on a network server, you can set up Windows on your system from the 
network. Check with your system administrator for any special instruc
tions before setting up Windows over a network. 

Note For information about copying Windows files to a network serv
er, see the next section, "Placing Windows Files on a Network Server." 
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Windows can be set up from a network in three ways: 

• All Windows files are copied to your computer. 

In this situation, you create your own copy of Windows on your sys
tem. All Windows files are copied to your hard disk. 

To set up Windows, you connect to the network server and type 
setup (do not use the In network option). Follow the instructions on 
the screen. It is recommended that you use Express Setup; however, 
you can use Custom Setup. Both methods are described earlier in 
this chapter. 

• Personal Windows files are copied to your computer; shared 
Windows files are located on the server. 

You can set up your system to access a shared copy of Windows. In 
this case, most Windows files are located on a network server and 
are shared by you and other users. During Setup, a few Windows 
files are copied to your personal Windows directory on your hard 
disk. By maintaining your own copies of these files, you can cus
tomize Windows according to your preferences. 

To set up Windows this way, use the setup In option, described in 
the procedure following this list. 

• No Windows files are copied to your computer. 

If your machine is a diskless workstation (that is, it does not have a 
hard disk), no files can be copied to your system. When running 
Windows, you use shared Windows files located in a network 
Windows directory. During Setup, a few Windows files are copied 
to your personal Windows directory on the server hard disk and mod
ified for your use. 

To set up Windows this way, use setup In, described in the 
following procedure. When Setup asks you where it should put 
your Windows files, specify the name of your personal Windows 
directory, located on the server hard disk. If you are not sure which 
network directory you should use as your personal Windows 
directory, ask your network system administrator. 
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~ To set up a personal copy of Windows from a shared network 
directory 

1. Connect to the network. 

2. Change to the directory where Windows is located on the network 
(for example, W:\WINSHARE). 

3. At the MS-DOS prompt, type setup In 

4. Follow the instructions on the screen. 

It is recommended that you use Express Setup; however, you can 
use Custom Setup if you want. Both methods are described earlier in 
this chapter. 

Setup will ask where it should put your Windows files. Type the 
path of your personal Windows directory-for example, c:\windows 
(or u:\winuser, for a diskless workstation). 

Note If you have a set of Windows disks, do not attempt to set up a net
work copy of Windows from the disks (by typing setup In). You can 
run setup In only if you are setting up Windows from a network server. 

If you are using an English version of Windows version 3.1 to upgrade 
a non-English version of Windows version 3.0, you need to use Custom 
Setup. In the System Information screen, choose the English names 
of drivers you previously installed in your non-English version of 
Windows. 

In addition, some of your installed device drivers that were not origi
nally supplied with Windows might not be upgraded. After setup, you 
may need to obtain new third-party drivers (such as those supplied by 
hardware manufacturers) and update them by running Setup from 
within Windows. 
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Placing Windows Files on a Network Server 
Windows has an administrative setup option you can use to place 
Windows files on a network server. The administrative option does not 
set up a usable copy of Windows that you can run, but transfers the 
files from the Windows Setup disks to a network drive. The files are 
expanded, renamed, and marked as read-only when they are copied to 
the network drive. After the Windows files are copied to a directory 
on the network, users may connect to this directory and run the Setup 
program to set up Windows for their own workstations. 

~ To place Windows files on a network server 

1. Insert the Windows version 3.1 disk 1 in a drive. 

2. At the MS-DOS prompt, type the drive letter of the drive. 

3. Type setup la 
4. Follow the instructions on your screen. 

Setup prompts you to specify the network drive and directory to 
which you want the Windows files copied. You're also prompted to 
specify group registration information (group name and company 
name), which is stored and used when individual workstations are 
set up. 

Windows requires the following disk space for network files: 

• Shared network directory - 16 MB 

• Personal network directory - 300K 

Setup Facts 
You do not need the information in this section to set up Windows, but 
you may be interested in the following facts about Windows and the 
Setup program. 
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Disk Space and Setup Time Required by Windows 
Setting up Windows requires different amounts of space on your hard 
disk, depending on your system. 

The following are the requirements for a typical 80386 system. 

Setup type 

New 

Upgrade 

Minimum space 

8.0MB 

5.0MB 

Maximum space 

10.0 MB 

5.5MB 

The following are the requirements for a typical 80286 system. 

Setup type 

New 

Upgrade 

Minimum space 

6.0MB 

5.0MB 

Maximum space 

9.0MB 

5.5MB 

Note Minimum disk-space requirements include no optional com
ponents, network, or printer. Maximum requirements include all 
components installed, including a printer and network. 

Although setup time can vary, depending on the speed of your system 
and whether you use Express or Custom Setup, you should expect to 
spend no more than 20 to 30 minutes to set up Windows. 

Setup Summary 
The Windows Setup program: 

• Determines what hardware you are using. 

• Decompresses Windows files from the Windows disk set and copies 
the files to your hard disk. 

• Configures SYSTEM.INI and WIN.INI (files that are used to 
customize your copy of Windows). 

• Searches your hard disk for applications to set up for use with 
Windows, and creates program-item icons for these applications. 
You can then start an application simply by choosing its icon. 
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• Creates program information files (PIFs) and program-item icons for 
any known non-Windows applications you currently have on your 
system. PIFs supply Windows with essential information about how 
to run the applications with Windows. 

• Modifies your AUTOEXEC.BAT and CONFIG.SYS files as 
described in the following section. (Express Setup does this auto
matically. During Custom Setup, you can choose whether or not to 
have Setup modify these files.) 

• Restarts your system (if you want), so that all changes that were 
made to your system during Setup take effect immediately. 

Note If you quit Setup before Windows has been completely set up (by 
pressing F3, for example), Windows will not be properly set up on your 
system. You will need to run Setup again before you can use Windows. 

Changes to the AUTOEXEC.BAT and CONFIG.SYS Files 
Setup makes the following changes to your AUTOEXEC.BAT file: 

• Adds to your PATH setting the directory where you are setting up 
Windows. 

• Adds the SMARTDRV.EXE command line, if appropriate for your 
system configuration. 

• Creates a TEMP directory in the Windows directory and sets the 
TEMP variable to it (if you have not already set the variable). 

Setup makes the following changes to your CONFIG.SYS file: 

• Adds the HIMEM.SYS line. For example: 

device=c:\windows\himem.sys 

• Adds the SMARTDRV.EXE Idouble_buffer line, if needed. For 
example: 

device=c:\windows\smartdrv.exe Idouble_buffer 

• Updates RAMDRIVE.SYS, if it is in use. 

• Updates EMM386.EXE, if appropriate. 

• Updates your Microsoft or Hewlett-Packard mouse driver. 

• Deletes any incompatible device drivers. 
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• Adds or updates your EGA.SYS device driver if you are using an 
enhanced graphics adapter (EGA) or a Mouse Systems mouse. 

• Adds the appropriate parameter to the 386MAX line, if it is present. 

Note If you have problems setting up Windows, see Chapter 4, 
"Troubleshooting." 

Starting Windows 
At the end of the Setup program, you can choose whether to restart 
Windows or return to the MS-DOS prompt. You can start Windows 
from the MS-DOS prompt at any time. 

~ To start Windows from the MS-DOS prompt 

• Type win, and then press ENTER. 

Note To have Windows start automatically when you turn on your 
computer, add the line win at the end of your AUTOEXEC.BAT file. 
For more information about A UTOEXEC.BAT, see your MS-DOS 
documentation. 

The Windows Command Line 
The text you type at the MS-DOS prompt is called the command line. 
To start Windows and use the default mode (either 386 enhanced or 
standard), you can use the win command. However, you might want 
to start Windows in a particular mode, or have a particular application 
start when Windows starts. This section describes how to use two types 
of Windows startup methods: options and run commands. 

The Windows command line tells your computer: 

• To start Windows. 

• What mode to start Windows in (optional). 

• The application or command that you want Windows to run when it 
starts (optional). 

The Windows command line has the following form: 

win [options] [run command] 



Chapter 1 Setting Up Windows 13 

The win portion of the command line instructs MS-DOS to start 
Windows. You must include the win portion of the command line; the 
rest of the command line is optional. 

The options portion of the Windows command line represents options 
that specify which mode to run Windows in. For more information, see 
"Starting Windows in a Specific Mode" later in this chapter. 

The run command portion of the Windows command line represents 
text that you can include to start an application when you start 
Windows. For more information, see "Specifying a Run Command" 
later in this chapter. 

Windows Modes 
Windows can run in two modes: standard mode and 386 enhanced 
mode. When you type win, Windows responds to your system's con
figuration by starting in the most appropriate mode for your system. 
(When Windows is running, you can find out which mode Windows 
is running in by choosing the About command from the Help menu in 
Program Manager or in applications in the Main or Accessories group.) 

Windows uses the following criteria when determining which mode to 
use: 

• Windows runs in 386 enhanced mode if you have an 80386 com
puter (or higher) with at least 640K of conventional memory plus 
1024 K of extended memory. 

• Windows runs in standard mode if you have an 80286 computer 
(or higher) with at least 640K of conventional memory plus 256K 
of extended memory. Windows also runs in standard mode with 
80386 computers that have less than 2 MB of memory. 

Starting Windows in a Specific Mode 
At times you might want to run Windows in a specific mode, even 
if it is not the most efficient one for your system. For example, if your 
system is a 80386 computer with between 2 and 3 MB of memory and 
you do not want to run non-Windows applications in Windows, you 
may decide to run Windows version 3.1 in standard mode to speed up 
performance. For more information about improving performance, see 
Chapter 14, "Optimizing Windows," in the Microsoft Windows User's 
Guide. 
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To ensure that Windows runs in a particular mode, include the option 
for that mode on the Windows command line when you start Windows. 
For example, to start Windows in standard mode, type win Is. 

You can specify one of the following options. 

Use To 

Is Run Windows in standard mode. 

You might want to use this option if you have an 80386 computer 
with 640K conventional memory plus 1024K to 2096K extended 
memory and do not use non-Windows applications with 
Windows. On such systems, Windows runs faster in standard 
mode than in 386 enhanced mode. 

You might also want to use this option if you are having hardware 
compatibility problems when running in 386 enhanced mode. 

13 Run Windows in 386 enhanced mode. 

You can use this option if you want to run Windows in 386 
enhanced mode even though your 80386 (or higher) computer 
has less than the 2 MB of memory that 386 enhanced mode nor
mally requires. This option works only on 80386 systems with at 
least 1 MB of memory (640K conventional, 384K extended). If 
your system has less than 2 MB of memory, Windows probably 
runs slower in 386 enhanced mode than in standard mode. 
However, you may be able to run more Windows applications 
at once in enhanced mode. 

Specifying a mode is optional. If you do not specify a mode, Windows 
starts in the mode most appropriate for your system. 

Specifying a Run Command 
You can use the runcommand portion of the Windows command line 
to run a particular application or command immediately after starting 
Windows. For example, the following command line starts Windows 
and then starts Microsoft Excel: 

win c: \excel\excel.exe 

The run command portion of the Windows command line is identical to 
the text you type after choosing the Run command from the File menu 
in Program Manager or Windows File Manager. For more information 
about the Run command, see Chapter 2, "Application Basics," in the 
Microsoft Windows User's Guide. 
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The run command text must follow any options you include on the 
Windows command line. For example, the following command line 
starts Windows in standard mode and then runs the application 
MYEDITOR.EXE: 

win Is myeditor.exe 

Note You can also set up one or more applications to run at startup 
by adding their program-item icons to the StartUp group in Program 
Manager. For more information, see Chapter 3, "Program Manager," 
in the Microsoft Windows User's Guide. 

Some Sample Windows Command lines 
This section describes some command lines that illustrate the Windows 
startup methods. 

Sample One: Starting Windows and an Application The follow
ing command line starts Windows and then runs the application 
TEXTEDIT.COM, which is in the EDITORS directory on drive D: 

win d:\editors\textedit.com 

Sample Two: Starting Windows and Opening a Document The fol
lowing command line starts Windows in standard mode and then opens 
the document AGENDA. TXT in Windows Notepad: 

win /s agenda. txt 

The command line runs Notepad because Windows associates all 
files that have the .TXT filename extension with Notepad. You 
can change such file associations in File Manager by choosing the 
Associate command from the File menu. For information, see Chapter 
4, "File Manager," in the Microsoft Windows User's Guide. 

Sample Three: Starting Windows and an Application, and Opening 
a Document The following command line starts Windows, runs 
Microsoft Word, and then opens the Word document LETTER.DOC: 

win c:\word\word.exe letter.doc 





New in This Version 

Chapter 2 

This chapter highlights some of the new and enhanced features and 
many of the performance improvements in Windows version 3.1. 

TrueType Fonts 
One of the most dramatic features in Windows version 3.1 is the addi
tion of TrueType fonts. TrueType provides you with a full set of fonts, 

enough variety to meet virtually all your printing needs. 

fonts are scalable, so you can choose the exact font size you 
your documents. For example, you can use the same font at 12 

for the main text of a report and at 16 points for topic heads. On 
(lUE-Illarnx or laser printer, the page you print will appear exactly as 

see it on the screen, without your having to obtain special screen, 
cartridge, or soft fonts. 

Windows version 3.1 supplies several families of TrueType fonts, in
cluding Arial, Courier New, Symbol, and Times New Roman. You can 
easily add other TrueType fonts from a font manufacturer to enhance 
your Windows applications. 

For more information about using TrueType fonts, see Chapter 5, 
"Control Panel," in the Microsoft Windows User's Guide. 
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Object Linking and Embedding 
Object linking and embedding is now available in applications such as 
Microsoft Excel, Ami Professional, and WordPerfect, in addition to 
Windows Paintbrush, Write, Cardfile, and Sound Recorder. Object link
ing and embedding enables you to transfer and share information in a 
powerful new way. 

• Object embedding 

With object embedding, you can create a drawing, sound file, or 
other object by using an application such as Paintbrush or Sound 
Recorder, and then insert (embed) it into another document. You 
can edit the embedded information from within your document. 

For example, suppose you are working on a report in which you 
have embedded a drawing. To make changes to the drawing, you 
choose it; Paintbrush opens. You can then make changes to the draw
ing, save it, and return to your report. You don't have to remember 
where the drawing is: Windows finds it for you. 

• Object linking 

With object linking, you can use the same information (the object) 
in several documents. An object can be any kind of information, 
including text, a drawing, or a sound file. You create the object and 
then connect (link) it to as many documents as you want. 

When you edit the information in any of the documents, your 
changes are reflected in all the other documents that contain the 
same linked information. You save time and effort because you 
don't have to perform a cut-and-paste operation for each document 
every time you change the information. You save disk space because 
only one copy of the information exists-the documents contain 
only the links. 

For more information about object linking and embedding, see Chapter 
13, "Integrating Your Windows Applications," in the Microsoft 
Windows User's Guide. 
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A New File Manager 
Windows File Manager has a new look: a split window with a directory 
list on the left and the contents of the "open" directory on the right. 
You can browse the file system easily without having to open separate 
windows. File Manager has several other enhancements, including: 

• The ability to display the contents of more than one drive or 
directory at once. This makes it easy to copy and move files and 
subdirectories from one directory or drive to another. 

• More clearly labeled windows, disk drives, and network paths, 
making it easier to use File Manager. 

A variety of fonts you can use to display information in the File 
Manager window. This allows you to control how much file infor
mation is displayed in the File Manager window at a time. 

• Enhanced network support that makes it easy to connect to and 
disconnect from network drives. (The specific menu commands 
that appear depend on the network you are using.) 

• A Quick Format option so that you can format a floppy disk and 
then copy files to it without having to start MS-DOS Prompt or quit 
Windows. 

• More information about disk-space usage and availability. 

For more information about using File Manager, see Chapter 4, 
"File Manager," in the Microsoft Windows User's Guide. 

Drag and Drop 
The new "drag and drop" feature makes it easy to print, copy, or move 
a file in File Manager. You simply drag a file icon from one location to 
another by using the mouse. For example, you can print a file by drag
ging its file icon from File Manager and dropping it onto the minimized 
Print Manager window. 

If you want to create a new program item to use to start an application, 
you can drag the application's file icon from File Manager and drop it 
onto a group icon or window in Windows Program Manager. 

For more information about dragging and dropping files, see Chapter 4, 
"File Manager," in the Microsoft Windows User's Guide. 
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Online Tutorial 
Windows version 3.1 offers an online Tutorial in which you can prac
tice working with a mouse and performing basic Windows tasks. 

To run the Microsoft Windows Tutorial, you need a mouse and a VGA 
(or better) monitor. 

You can run the Tutorial when you run Windows Setup or at any time 
afterward. To run the Tutorial after you have set up Windows, choose 
the Windows Tutorial command from the Help menu in Program 
Manager. 

Printing Enhancements 
Installing printers and connecting to network printers are now easier 
and smoother-you can perform these tasks by using either Windows 
Print Manager or Windows Control Panel. 

In addition, several of the Windows printer drivers have been 
. mproved, making it quicker and easier to print files. For example, 

pport has been added for printing at a baud rate of 19200 on a 
ewlett-Packard LaserJet Series II or III printer. If you are using this 

e of printer, you can take full advantage of this feature and increase 
rinting speed dramatically. For more information, see the manual that 

comes with your HP LaserJet printer. 

Print Manager now is faster and more efficient, returning control to 
your applications sooner. This allows you to quickly return to working 
on your documents while other documents or files are being printed. 

,And remember-you can print most files just by dragging their file 
'~tons from File Manager onto the minimized Print Manager window. 

For more information about printing, see Chapter 6, "Print Manager," 
in the Microsoft Windows User's Guide. 
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New Multimedia Features 
Windows version 3.1 has several new features that enable applications 
to use multimedia devices, so that different kinds of media, including 
sound, graphics, animation, and video, can be added to files and docu
ments. Included with the new multimedia features is support for many 
popular sound devices, such as sound cards and devices with Musical 
Instrument Digital Interface (MIDI) capabilities. 

With the new Windows sound support, you can perform simple sound 
tasks, such as selecting sounds to play when you start or quit Windows, 
in addition to more sophisticated tasks, such as playing MIDI informa
tion on a MIDI synthesizer or recording voice annotations to include in 
a document. 

You can also use other applications that take advantage of the complete 
set of Windows multimedia features, including the use of animation, 
CD-ROM drives, and video support. For example, you could use a 
CD-ROM encyclopedia that includes sound. Using a video graphics 
adapter (VGA), you could use a presentation application to create 
presentations that include both motion and sound. 

The following are among the sound features included with Windows: 

• Media Player 

Media Player is a new Windows application you can use to control 
the playing of various kinds of media files on hardware such as 
sound cards, CD-ROM drives, and videodisc players. It can play 
animation, sound, and MIDI sequencer files. For more information 
about using Media Player, see Chapter 12, "Additional Accessories," 
in the Microsoft Windows User's Guide. 

• Sound Recorder 

With Sound Recorder, you can play, record, and edit sound files 
that have the W AVE format. You can then assign the sounds that 
you record to system or application events, or use the sounds in 
other applications that support object linking and embedding. 

The Sound Recorder window graphically displays the sound wave 
as if it were being displayed on an oscilloscope. For more infor
mation about using Sound Recorder, see Chapter 12, "Additional 
Accessories," in the Microsoft Windows User's Guide. 
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• Enhancements to Control Panel 

Control Panel now provides options for setting up device drivers and 
controlling how sound works in Windows. With the new Drivers 
option, you can set up drivers for almost any device you want to use. 
Although most devices come with the appropriate driver, Windows 
also supplies sound drivers for common sound devices. 

Using the enhanced Sound option in Control Panel, you can now 
assign unique sounds to different system and application events. For 
example, you can select a sound to play every time you start or quit 
Windows, when an application displays a message, or in place of 
your computer's warning beep. 

If you are using sound devices that have MIDI capabilities, such as 
a synthesizer, you can use the new MIDI Mapper option in Control 
Panel to specify MIDI settings for your device. Note that MIDI 
Mapper is available only if you have a driver installed that supports 
a MIDI device. 

For more information about the new driver and sound support in 
Control Panel, see Chapter 5, "Control Panel," in the Microsoft 
Windows User's Guide. 

Additional Features and Enhancements 
The following list highlights additional features and enhancements in 
Windows version 3.1 : 

• Setup enhancements 

Setup has been greatly simplified. You can now choose Express 
Setup and have the Setup program automatically set up Windows. 
You just type your name and answer a few simple questions, such 
as what type of printer you have. 

If you need more control over how Windows is set up-for example, 
if you want to set any special printer options or choose not to set up 
some Windows components-you can use Custom Setup. Chapter 1, 
"Setting Up Windows," in this book provides detailed instructions 
on how to set up Windows on your computer, using both methods. 
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• Improved support for non-Windows applications 

Windows now includes program information files (PIFs) for even 
more non-Windows applications. These files are set up when you 
add your non-Windows applications to Program Manager, making 
it easier to run these applications from within Windows. 

Note A non-Windows application is designed to run with MS-DOS 
but not specifically with Windows. 

When you run Windows in 386 enhanced mode, improved virtual
memory functions make it smoother to run several non-Windows 
applications in the background and to switch between them. 

Full mouse support has been added to non-Windows applications 
running in a window. You can now use your mouse to move around 
in and select items in these applications. 

Different font sizes are available for your non-Windows applica
tions, so you can pick the font size that best suits your needs. 

Also included is a collection of icons (in the MORICONS.DLL file) 
that represent many of the most popular non-Windows applications. 
You can now use these icons when adding non-Windows applica
tions to Program Manager. 

For more information about running non-Windows applications in 
Windows, see Chapter 7 , "Non-Windows Applications," in the 
Microsoft Windows User's Guide. 

• Network enhancements 

When you restart Windows, your system is reconnected to all the 
printers and network drives you were previously connected to. For 
more information about using networks, see Appendix A, "Windows 
and Networks," in the Microsoft Windows User's Guide. 
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• Character Map 

Windows Character Map is a new accessory application that you can 
use to insert special characters not found on your keyboard into your 
application. These characters include accented characters and 
characters in the Symbol fonts. For more information about using 
Character Map, see Chapter 12, "Additional Accessories," in the 
Microsoft Windows User's Guide. 

• Object Packager 

Windows Object Packager is a new accessory application you can 
use when linking and embedding information. For more information 
about Object Packager, see Chapter 13, "Integrating Your Windows 
Applications," in the Microsoft Windows User's Guide. 

• Online Help enhancements 

In addition to a complete, indexed Help system for all of Windows, 
you can now get context-sensitive Help for the task you are perform
ing at the moment. Context-sensitive Help is available in all dialog 
boxes in the following Windows applications: Windows Setup, 
Program Manager, File Manager, Print Manager, PIF Editor, and 
Control Panel. Now, getting information about the task you are 
performing is as easy as choosing the Help button or pressing Fl. 

For more information about using Help, see Chapter 1, "Windows 
Basics," in the Microsoft Windows User's Guide. 

• Improved startup configuration 

When Windows starts, it runs (or loads) any applications whose 
program-item icons you placed in the new StartUp group in Program 
Manager. 

In Program Manager and File Manager, you can preserve the con
tents and positions of windows and icons, and any menu settings you 
change, from one Windows session to the next. 

For more information about using Program Manager, see Chapter 3, 
"Program Manager," in the Microsoft Windows User's Guide. 
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• More ways to customize your desktop 

Windows version 3.1 now has more desktop color schemes to 
choose from, including three designed for use with LCD monitors. 

Also included are screen savers that display moving graphics or text 
on your screen while you are not actively working with Windows. 
Screen savers reduce the wear on your screen and can be password
protected so that your work remains private. For more information 
about the new desktop features, see Chapter 5, "Control Panel," in 
the Microsoft Windows User's Guide. 

• Serial-port enhancements 

Windows now includes additional communications settings for 
your serial ports. You can use serial ports that were not previously 
recognized by Windows and set separate interrupts for ports 1 and 
3, in addition to ports 2 and 4, so that you can use these ports simul
taneously. For more information about this feature, see Chapter 5, 
"Control Panel," in the Microsoft Windows User's Guide. 

• Standardized dialog boxes 

Many of the common dialog boxes, such as those that appear when 
you choose the Open, Save As, Browse, and Print Setup commands, 
now look the same throughout Windows, making tasks easier to per
form between Windows applications. For more information about 
performing these tasks, see Chapter 2, "Application Basics," in the 
Microsoft Windows User's Guide. 

• New collection of application icons 

Program Manager now offers a collection of icons that you can 
choose from to represent your applications. Whether you are adding 
an application to a group or changing application information, you 
can choose the most suitable icon. 

Also included is a file (MORICONS.DLL) that contains icons used 
to represent non-Windows applications. 

For more information about how to use these icons, see Chapter 3, 
"Program Manager," in the Microsoft Windows User's Guide. 
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Performance Improvements 
Windows version 3.1 includes many significant improvements to over
all performance. For example: 

• Program Manager now requires less system memory, so you can 
create more groups without using up memory. 

• File Manager is much faster: Your screen updates faster when you 
move and copy files and when you search drives and directories. In 
addition, you can now quit a time-consuming process before it is 
complete-for example, you can stop a CD-ROM drive search if 
you need to use your computer. 

• Running a non-Windows application in a window is now much 
faster in 386 enhanced mode. Also switching between Windows and 
a non-Windows application is smoother and faster. 

• Printing is faster and more efficient: Your documents print faster, 
and control is returned to your applications sooner. 

• Disk-caching is improved with SMARTDrive. Opening, saving, and 
managing files by using non-Windows applications is now smoother 
and faster. 



A Brief Tour of Microsoft Windows 

Chapter 3 

Introduction 
This chapter introduces you to the Microsoft Windows operating sys
tem version 3 . I-what it is, what it looks like, and how it works. You 
may want to tryout some of the Windows features as you read this 
chapter. 

This tour is designed for mouse users. If you don't have a mouse, the 
tour can still provide a good overview of Windows. To learn about 
specific keyboard procedures, see Chapters 1 and 2 in the Microsoft 
Windows User's Guide. 

If you are new to using a mouse, you can use the online Microsoft 
Windows Tutorial either during the Setup program or later from within 
Windows. The first Tutorial lesson introduces you to basic mouse pro
cedures. For more information, see "Running the Microsoft Windows 
Tutorial" at the end of this chapter. 

If Windows is not yet set up on your system, read Chapter 1, "Setting 
Up Windows," in this book before continuing. 
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Starting Windows 
After Windows is set up on your computer, it is easy to start: 

• At the MS-DOS prompt (for example, C», type win, and then 
press ENTER. 

Windows Basics 
As you work with Windows, there are a few basic terms you need to 
become familiar with. 

You do your work in rectangular areas of the screen called windows. 
These windows appear on a background called the desktop. The appli
cations you work with (such as your word processing or spreadsheet 
programs) are represented in Windows by small graphical symbols 
called icons. 
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You often carry out an action in Windows by choosing an item: for 
example, choosing an icon can start an application. You choose an 
icon by double-clicking it. 

These icons represent 
applications you can run. 

@ ~ 
PIF Editor Read Me 

The screen background is 
known as the desktop. 

These areas are 
windows. 
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Program Manager 
When you start Windows, the first thing you see is Program Manager, 
which continues to run as long as you are using Windows. Initially, the 
Program Manager window displays the contents of the Main group. A 
group is a collection of applications you can run with Windows. The 
names and icons for the applications in the group are displayed in the 
group window. 

Windows Program Manager also displays icons for other groups of 
applications: Accessories, Games, and StartUp. 

Note Your Program Manager window may contain another group 
icon called Applications. During Windows Setup, applications already 
installed on your computer can be set up for you to use with Windows. 
The Applications group window contains icons for those applications. 

You can perform many important tasks by using Program Manager. 
For example, you can: 

• Start applications. 

• Organize your applications into groups for easy access. 

• Quit Windows. 
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The following illustration points out some of the Windows features 
displayed when you first start Windows. 

The Main group window shows the main 
applications included with Windows. 

The title bar identifies the application 
(or group) in the window. 

.., 
Windows 

Setup 

@ ~ 
PIF Editor Read Me 

Accessories Games StartUp Applications 

Group icons represent other 
groups of applications, 
similar to the Main group. 

Starting an Application 

The mouse pointer is 
used to select and move 
objects on the screen. 

From Program Manager, you can easily start an application by using 
the mouse to double-click (or "choose") its icon, called a program-item 
icon. Icons for many applications are in groups other than the Main 
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group, so you may need to open another group window to find the icon 
you want. For example, you need to open the Accessories group to start 
Windows Notepad. 

.., 
Windows 

Setup 

Accessories 

~ 
PIF Editor Read Me 

Games StartUp Applications 

You can open a group window 
by double-clicking the group icon. 

The Accessories group window displays icons for additional applica
tions you can run. 

Write Paintbrush Terminal 

eJ (lliJ III fJ 
Cardfile Calendar Calculator Clock Object 

Packager 

If 
Character Map Media Player Sound 

Recorder 
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When you double-click ("choose") the icon, in this case Notepad, the 
application appears in an application window, ready for you to work 
with it. 

The Notepad window is now the active window. The active window 
is generally the window in the foreground. To make another window 
active, you click anywhere in the window. 

You can start an application by 
double-clicking its program-item icon. 

Calculator Clock Object 
Packager 

Sound 
Recorder 
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Using a Menu 
In each application window, and in other windows as well, is a list of 
menu names beneath the title bar. A menu contains a list of commands, 
which are actions you can carry out with Windows. You click menu 
names and commands once to choose them. 

Clicking a menu name displays 
the commands on the menu. 

Clicking a command 
carries out an action. 

Notepad is a text editor that you can use to edit small !~:xt.fiJ.E;l;.1, 
such as your CONFIG.SYS or AUTOEXEC.BAT file. 

To learn howto use Help, press F1. 

How To ... 

In this case, the command 
opens a Help window. 
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Reducing an Application Window to an Icon 
As you work with Windows, you may want to temporarily put aside an 
application but keep it easily available to use later. You can avoid clut
ter on your screen if you reduce the application window to an icon by 
clicking its Minimize button; the icon stays on the Windows desktop 
until you need to use the application again. 

You can reduce an application window to 
an icon by clicking the Minimize button. 

The application is still running and available, but takes up less space as 
an application icon. 

Application icon 

8 
Object 

Packager 
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Quitting an Application 
U sing a mouse, quitting an application is as easy as starting it. 
The quickest method of quitting is to double-click the application's 
Control-menu box. (You can also press ALT+P4. Or you can click the 
Control-menu box once to display the Control menu, and then click 
the Close command.) 

I 
You can quit an application by 
double-clicking its Control-menu box. 

Eile .Edit .s.earch tlelp 

The application window closes. If you have any unsaved work, you are 
prompted to save it before quitting the application. 

More Ways to Use Program Manager 
You can also use Program Manager to: 

• Add applications to a group and delete applications from a group. 

• Create and delete groups. 

• Add applications to the StartUp group so that they start when 
Windows starts. 

For details on these and other uses of Program Manager, see Chapter 3, 
"Program Manager," in the Microsoft Windows User's Guide. 
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File Manager 
Windows File Manager provides a graphical representation of files and 
directories to help you organize them and simplify file maintenance. 

You can start File Manager by double-clicking its icon in the Main 
group window. 

You can perform many tasks by using File Manager. For example, 
you can: 

• View the contents of your directories. 

• Move, copy, and delete files and directories. 

• Change to other disk drives, including network drives. 

This is a directory icon. These are file icons. 

The status bar shows available and 
total disk space and the amount of 
space the open directory is using. 
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Files and Directories 
A file is an electronic document or an application that has been 
given a name and stored on your computer. A file could be a memo 
you have written, or it might be the word-processing application you 
used to write the memo. Files have names such as LETTER. TXT and 
APPLICTN.EXE and can be stored on your computer in directories. 

A directory is a collection of files and/or other directories (called 
subdirectories) that are stored at the same location on a disk. Two 
directories that are likely to be on your computer are WINDOWS 
and SYSTEM. 

C:\ Drive 

1 } Directories 

~------~~~W~~IN~D~o~w~s~~~1 

REPORTS 

1-----1 SYSTEM Subdirectory 

f-------- calc.exe 

f-------- calc.hlp Files 

~------ calendar.exe 
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The WINDOWS directory contains the SYSTEM subdirectory, in addi
tion to many of the Windows files. The SYSTEM directory contains 
additional files. 

A directory window is a window that appears in the main File Manager 
window. A directory window graphically displays the relationship of 
the directories and files that are stored on a disk drive. 

The left side of the window displays the directory tree, and the right 
side displays the contents of the current directory. 

The directory tree displays directories 
on the drive you are using. 

The contents list displays files and 
subdirectories in the selected directory. 
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Viewing Directory Contents 
Using File Manager, you can easily scan the contents of a directory. 
Just open the directory by clicking its name or icon on the left side of 
the window. 

In the following illustration, the REPORTS directory is open, with its 
contents displayed at the right. 

logo.bmp 
[jj[JmaLwri 
I:J mkreport. exe 

Dtables [jj[J notes. txt 
D accounts.bak D sales.dat 
D accounts.dat L':3showart.bat 
ffiI apLwri 
~feb.wri 
ffilian.wri 
D letters. log 

Contents of the REPORTS directory 

You can open a different directory, such as WINDOWS, by clicking its 
icon or name. The information in the right side of the window changes, 
displaying the contents of the WINDOWS directory. 

Contents of the WINDOWS directory 
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Scrolling to View Information 
When an application has more text or graphics than can be displayed in 
its window at one time, you can use scroll bars to bring the rest of the 
information into view. Scroll bars appear along the right side or bottom 
of any window whenever there is too much information to fit in the 
window. 

These scrolling techniques will be useful in much of your work with 
Windows. 

Clicking these arrows displays information 
above or below what is currently visible. 

Clicking these arrows displays information 
to the right or left of what is currently visible. 

Moving and Copying Files 
With the "drag and drop" feature available in File Manager, you can 
use your mouse to move or copy files quickly. 

For example, to copy a file from your hard disk to a disk in drive A, 
first position the mouse pointer on the file icon. Then press and hold 
down the left mouse button and move (drag) the file icon to the drive 
icon. Finally, release the mouse button, dropping the icon onto the 
drive icon. 
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When you move or copy files in File Manager, your mouse pointer 
appears as in the following illustration. 

You can copy a file to another drive 
by dragging its icon to the drive icon. 

You can also move and copy files from one directory to another by 
dragging file icons. 

• You can move a file by dragging the file icon to the destination 
directory icon or window. 

• You can copy a file by holding down the CTRL key while you drag 
the file icon to the destination directory icon or window. 

For more information about moving and copying files, see Chapter 4, 
"File Manager," in the Microsoft Windows User's Guide. 

Changing Disk Drives 
Using File Manager, all of your disk drives are readily available, 
even any network drives you are connected to. 

Each File Manager directory window displays icons for all drives 
on your system-floppy disk drives, hard disk drives, and network 
drives-in the space beneath the window title. The icon of the 
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current drive is outlined. The files and directories on the current 
drive are those displayed in the directory window. 

The drive you are currently 
using is outlined. 

You can change to another 
drive by clicking its drive icon. 

When you click another drive icon, the directory window displays the 
contents of that drive. Double-click the drive icon to open an additional 
directory window. 

More Ways to Use File Manager 
You can also use File Manager to: 

• Connect to network drives. 

• Format and maintain disks. 

• Print documents. 

• Start applications. 

• Change the kind and amount of information displayed about 
each file. 

• Create new directories and subdirectories. 

For details on these and other File Manager procedures, see Chapter 4, 
"File Manager," in the Microsoft Windows User's Guide. 
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Control Panel 
Windows Control Panel is a tool you can use to adjust settings on your 
system, such as changing the look of your Windows desktop and con
figuring certain hardware. 

You can start Control Panel by double-clicking its icon in the Main 
group window. 

You can perform many tasks by using Control Panel. For example, 
you can: 

• Add and remove fonts. 

• Change screen colors and desktop options. 

• Set options for your printer. 

Each Control Panel icon represents a set of system settings you can 
change. 

U sing the window that appears when you choose a Control Panel 
icon, you can make changes such as adding and removing fonts. 
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Double-click the icon for the 
settings you want to change. 

Date/Time Network 

Installed fonts: 
Arial (T rue Type) 
Arial Bold (TrueType) 
Arial Bold Italic TrueT e 

£ample 

aBbCcXxYyZz 123 i't 

T his is a scalable T rue Type font which can be 
displayed on the screen and printed on your printer. 

Size of Font on Disk: 66 KB 

Note Your fonts may be different from those shown here. 
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Using Dialog Boxes 
The windows you use when you make changes to settings are 
called dialog boxes. A dialog box requests information from you. 
For example, you might need to select certain options, type some 
text, or specify settings. You use dialog boxes to supply information 
throughout your work with Windows. 

Clicking this arrow displays a 
list of options to select from. 

~;~5Es~~~=1==~~ Clicking this command button 
displays another dialog box. 

L.....-...:\--__ ~-------' '---___ -=--=--=--=--=-~-HII-- Clicking this check box 
turns the option on or off. 

'----...... You can select only one of these 
option buttons at a time. 
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More About Control Panel 
The following list shows more of the kinds of settings you can change 
by using Control Panel. For a complete list, and for specific informa
tion about changing a setting, see Chapter 5, "Control Panel," in the 
Microsoft Windows User's Guide. 

• Change options for your mouse or other pointing device, such as 
the double-click rate. 

• Change settings for network connections. 

• Specify international settings for applications that use them. 

• Assign unique sounds to "system events." For example, you can 
have Windows play musical notes each time it starts, if you have a 
sound card. 

• Add, configure, or remove sound and Musical Instrument Digital 
Interface (MIDI) device drivers, if you have a sound card or MIDI 
device. 

Print Manager 
Windows Print Manager controls printing for Windows applications 
and helps you keep track of your print jobs. The Print Manager window 
shows the status of your printer(s) and the print jobs that are printing or 
waiting to be printed. 

You can view the Print Manager window by double-clicking its icon in 
the Main group window. 

Print Manager can be used to: 

• Check the status of a print job. 

• Pause and restart a print job. 

• Cancel a print job. 
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In Windows, you often need to select (highlight) an item before you 
carry out an action on it. For example, in Print Manager you click a 
print job to select it; then you can pause, restart, or cancel printing by 
clicking the appropriate button. 

r-----r- You use the Pause and Resume buttons to 
temporarily stop and restart printing. 

QMS-PS 810 on 

1 Calendar - SCHEDULE.CAL 

Checking Printer Status 

You can cancel a print job by selecting it, 
and then choosing the Delete button. 

4% of 458K 1 :43 PM 10/19/1991 

13K 1 :12 PM 10/19/1991 

This area displays the current 
status for the selected printer. 

A common use of Print Manager is to monitor the status of your print
ers and print jobs. This can be particularly useful when you are printing 
multiple jobs or printing on a network printer that is located where you 
can't see it. 
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This line shows the queue status for 
a printer that is directly connected to 
your computer. 

This line shows the queue status for 
a printer that you are connected to 
through a network. 

These iines display the status of 
files in the print queue that are 

printing or waiting to be printed. 

More Ways to Use Print Manager 
Using Print Manager, you can also: 

• Set up a printer. 

• Change priorities of print jobs. 

• Display printing messages. 

• Connect to and disconnect from network printers. 

For information about these and other uses of Print Manager, see 
Chapter 6, "Print Manager," in the Microsoft Windows User's Guide. 
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Switching Between Applications 
U sing Windows to run more than one application at a time can make 
your job much easier. But when you have opened several application 
windows, it may become difficult to find applications beneath over
lapping windows. 

An easy way to keep track of your applications is to use the Windows 
fast application-switching feature. You can switch quickly to another 
application by pressing and holding down the ALT key and then 
pressing the TAB key repeatedly. As you continue to press TAB, the 
title of each application currently running in Windows appears in 
the center of your screen. 

When you see the application you want, release ALT+TAR The applica
tion appears in the foreground. 

Task List 
Another method of managing your applications is to use Task List. 

With Task List, you can: 

• Display a list of all the applications you are currently running. 

• Switch quickly to any running application. 

• Rearrange windows and icons on your Windows desktop. 
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You can display Task List by double-clicking anywhere on the 
Windows desktop. Another method is to press CTRL+ESC. (If a menu 
is displayed, you need to press ESC first.) Or you can choose the 
Switch To command from any application's Control menu. 

You can switch to an application 
by double-clicking its name. 

The applications in the list are 
running on your system. 

The Task List buttons can be used to perform several functions: 

111Htllji;}liilHI 

1!!'iS,~li'ilI!II!1 

Switch To switches you to the selected application. 

End Task quits the selected application. 

Cascade layers windows on your screen. You see the title 
of each window. 

Tile resizes windows and arranges them side by side. 

Arrange Icons rearranges application icons along the 
bottom of your desktop. 

Cancel closes Task List. Or you can close it by pressing 
ESC. 

For more information about switching between applications, see Chap
ter 2, "Application Basics," in the Microsoft Windows User's Guide. 
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Help 
Windows provides online Help to assist you in working with Windows. 
Some of the ways you can obtain Help are: 

• Press the Fl key to see a list of Help topics for the application you 
are working in. 

• In a dialog box that has a Help button, click the Help button 
(or press Fl) to display information about working with the dialog 
box. 

• Choose the Help menu in any application to display a list of Help 
commands to choose from. 

The buttons near the top of the Help window can help you find the 
information you need. 

Contents for Print Manager Help 

Print Meneger provides e wey to view end control the printing of 
your documents. 

To leern howto use Help, press F1. 

I ntro d u cti 0 n 

\VheJ Is Print Mane.q8r? 
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Contents displays a list of Help topics for an application. 

Search displays a dialog box where you specify a topic to 
search for. 

Back displays the previously viewed topic. 

History displays a chronological list of all Help topics 
viewed during your current Windows session. 

Glossary displays a list of Windows terms and their 
definitions. 

If you need to learn how to use Help, press Fl while the Help window is 
open. Or choose How To Use Help from your application's Help menu. 

Quitting Windows 
You can quit Windows by double-clicking the Control-menu box in 
Program Manager. 

This is the Program Manager 
Control-menu box. 

File Manager 

A 
Windows 

Setup 

k]D peJ 
PIF Editor Read Me 

Accessories Games StartUp Applications 

Prompt 
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The Next Step 
This chapter has provided a brief introduction to Windows. The 
Microsoft Windows User's Guide provides details on the features pre
sented in this chapter. Also, you may want to use the Windows Tutorial 
that is available on your system. Instructions for running the Tutorial 
follow. 

Running the Microsoft Windows Tutorial 
The Windows Tutorial is an interactive, online application that teaches 
you the basics of using a mouse and Windows. To use the Tutorial, you 
need a mouse and a VGA (or better) monitor. 

~ To run the Tutorial from within Windows 

Mouse 

1. Switch to the Program Manager window by clicking it or by using 
Task List. 

2. Click the Help menu, and then click the Windows Tutorial command. 

Keyboard 

1. Switch to the Program Manager window: Press and hold down ALT, 

and then press TAB repeatedly until "Program Manager" appears in 
the small window in the middle of your screen. Then release both 
keys. 

The Program Manager window appears. 

2. Press ALT and then H to display the Help menu. 

3. Press w. Or press the DOWN ARROW key to select the Windows 
Tutorial command, and then press ENTER. 



Troubleshooting 

Chapter 4 

This chapter is designed to help if you run into trouble when using the 
Microsoft Windows operating system. Each section suggests steps you 
can take to solve the most common problems. 

This chapter has the following sections: 

• Setting Up Windows 

• Using a Mouse 

• Running Applications 

• Linking and Embedding Objects 

• Printing 

• Managing Memory 

• Using Serial Communications 

• Using Terminal 

• Using Windows with a Network 

• Using Two Versions of Windows 

• Before You Contact Product Support Services 

• Microsoft Product Support Services 

The section "Before You Contact Product Support Services" describes 
steps you should take before contacting Microsoft Product Support 
Services (PSS). In some cases, the steps might help you solve your 
problem. In other cases, the steps prepare you for the technician's 
questions. 
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Setting Up Windows 
The following sections describe solutions to problems you might have 
when setting up Windows. 

Your system locks up during the MS-DOS part of Setup. 
The first part of the Windows Setup program runs with MS-DOS. 
(Later, Setup switches to Windows.) If the Setup program stops while 
still using MS-DOS, it may be because Setup was unable to correctly 
detect your hardware. To solve this problem, run Setup again by typing 
setup Ii. This causes Setup to skip hardware detection and run Custom 
Setup, in which you specify your system settings. In the System Infor
mation screen, choose descriptions that match the hardware on your 
system. 

Setup stops when switching from MS-DOS to Windows. 
The first part of the Windows Setup program runs with MS-DOS. If 
Setup stops when switching from MS-DOS to Windows, it may be due 
to one of the following reasons: 

• When you started Setup, your system already had an application 
in memory that sends output directly to your screen. An example 
is a network message service that notifies you when printing is 
complete. Be sure to close any such applications before starting 
Windows Setup. 

• Setup was unable to correctly detect your hardware or software. 
You need to quit Setup and run it again, choosing the Custom Setup 
option. If possible, Setup indicates which hardware or software is 
causing the problem. Make sure the descriptions of hardware and 
software in the System Information screen match what you have on 
your system. If not, correct the settings. 

• You are running the wrong version of MS-DOS. Windows 3.1 re
quires MS-DOS version 3.1 or later. To find out which version you 
are running, type ver at the MS-DOS prompt. If necessary, install a 
newer version of MS-DOS, restart your computer, and then run 
Windows Setup again. 
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• Your system has a memory-resident program (also known as a 
terminate-and-stay-resident program, or TSR) that is incompatible 
with Setup. Setup detects and notifies you about using certain pro
grams. Read the file SETUP.TXT for information about using 
specific programs with Setup or Windows. 

SETUP.TXT is a text file located on Disk 1 of your Windows disk 
set. Programs are listed alphabetically in the file. To look at the file, 
use a text editor you have on your system, or use the following pro
cedure. 

~ To view the SETUP.TXT file, using the MS-DOS prompt 

1. Type the following at the MS-DOS prompt: 

more < setup.txt 

The file is displayed, one screen at a time. 

2. To see the next screen, press the SPACEBAR. 

3. To quit viewing the file, press CTRL+C. 

You might need to remove from your CONFIG.SYS and 
AUTOEXEC.BAT files any command lines that specify memory
resident programs and then restart your computer. For more 
information, see "Before You Contact Product Support Services" 
later in this chapter. 

The Setup program keeps prompting you for the same disk. 
When you run the Setup program, you are prompted to insert disks one 
by one. If Setup doesn't recognize that you have inserted the disk you 
are being prompted for, it might be for one of the following reasons: 

• A disk-cache program (such as SMARTDrive) is caching the 
floppy disk. To correct the problem, use a text editor to open the 
CONFIG.SYS or AUTOEXEC.BAT file, and then disable or re
move the command line that specifies the disk-cache program. 

For this change to take effect, you must restart your computer 
(remove the Setup disk from the floppy disk drive first). Then run 
Setup again. 

• The system did not receive the message that you changed the floppy 
disk. To correct the problem, add a drivparm command to your 
CONFIG.SYS file, and then restart your computer. For example, if 
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you are setting up Windows from a 5.25-inch, 1.2-MB floppy disk 
drive labeled A, you would add the following line to the 
CONFIG.SYS file: 

drivparm=/d:O If: 1 

For this change to take effect, you must restart your computer 
(remove the Setup disk from the floppy disk drive first). See your 
MS-DOS documentation for more information about the drivparm 
command. 

You have special hardware to set up with Windows. 
To use your hardware with Windows, you install a device driver. A 
device driver is a file that instructs Windows how to communicate with 
your hardware. Windows includes drivers for most popular types of 
monitors, printers, and other devices. 

If your hardware is on the Windows Hardware Compatibility List (sup
plied with Windows) or can emulate hardware on the list, Setup installs 
the devices automatically. Otherwise, Windows drivers for your hard
ware may be available from the following sources: 

• Microsoft provides the Windows Driver Library (WDL), which 
contains device drivers made available after this version of Windows 
was released. The WDL is available on network services, including 
CompuServe, GEnie, Microsoft OnLine, various user-group 
bulletin-board services (BBSs on the APCUG network), and the 
electronic downloading service maintained by Microsoft (phone 
206-637-9009). Users who do not have a modem may obtain 
disks by contacting Microsoft Customer Support Services at 
1-800-426-9400. 

Note If your copy of Windows was purchased outside the United 
States, the package contains a subsidiary information card listing 
bulletin-board services (BBSs) from which you can obtain updated 
device drivers. The card also lists local subsidiary telephone num
bers you can call to obtain drivers if no BBS is available or you 
cannot access a BBS. 

• If the WDL does not include a driver for your hardware, contact 
your hardware manufacturer to find out whether a device driver is 
available that is compatible with Windows version 3.1. 
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Note CGA display drivers are no longer included with Windows. 
You can, however, obtain a CGA display driver from the WDL, as 
previously described in this section. 

You receive a message about memory-resident programs. 
The Setup program detects and warns you about some memory-resident 
programs that might not be compatible with Windows. For information 
about setting up and using specific memory-resident programs, see the 
SETUP. TXT file. SETUP.TXT is a text file located on Disk 1 of your 
Windows disk set. The programs are listed alphabetically in the file. To 
look at the file, use a text editor you have on your system, or use the 
procedure described in the section "Setup Stops When Switching from 
MS-DOS to Windows" later in this chapter. 

Windows won't start after a successful Setup. 
If you completed Setup but cannot start Windows, one of the following 
might be the cause: 

• The wrong hardware is specified for your system. This might occur 
because you ran Express Setup, and Setup was unable to correctly 
detect your hardware; or because during Custom Setup, you chose 
the wrong hardware settings. From the Windows directory, type 
setup at the MS-DOS prompt. Make sure the hardware information 
is correct. 

• Your system may be running memory-resident (TSR) programs that 
are incompatible with Windows. Setup detects and warns you about 
most of these programs; however, your system may have a program 
that Setup cannot detect. 

For more information about troubleshooting problems with 
memory-resident programs, see "Streamline the CONFIG.SYS 
and AUTOEXEC.BAT Files" later in this chapter. 

• If Windows still won't start, run Setup again. Type setup Ii, which 
causes Setup to skip hardware detection. This also runs Custom 
Setup, in which you specify your system settings. In the System 
Information screen, be sure to choose descriptions that match the 
hardware on your system. Then restart your system, and type win to 
start Windows. 

• Try starting Windows by typing win Is (standard mode) or win 13 
(386 enhanced mode). If you can start Windows in standard mode, 
see the next section. 
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Windows runs in standard mode but not in 386 enhanced 
mode. 
If you have an 80386 or 80486 computer and Windows can run only 
in standard mode, you may be able to correct the problem in one of the 
following ways: 

• Make sure that your computer has at least an 80386 processor and 
enough memory to run in 386 enhanced mode. You should have at 
least 200K of free conventional memory, 1024K (1 MB) of free 
extended memory, and at least 2 MB of free disk space. 

If your system meets these requirements, try to start Windows in 386 
enhanced mode by typing win /3 at the MS-DOS prompt. Although 
you can force Windows into 386 enhanced mode if it has less than 
1024K of extended memory, it is not recommended because 
Windows may run very slowly. 

• Use the EMMExclude option when you start Windows, by typing 
win /d:x at the MS-DOS prompt. This excludes the adapter area 
from areas that Windows searches for unused address space. Typi
cally, this is the area AOOO-FFFF. The search can cause conflicts 
with adapters that use this area. 

If using this command successfully starts Windows in 386 enhanced 
mode, you might want to add the EMMExclude command to your 
SYSTEM.INI file, as described in the procedure following this 
section. 

• Use the VirtualHDirq option when you start Windows, by typing 
win /d:v at the MS-DOS prompt. This gives your hard disk-rather 
than Windows 386 enhanced mode-control over how hard-disk 
interrupts are processed. 

If using this command successfully starts Windows in 386 enhanced 
mode, you might want to add the VirtualHDirq command to your 
SYSTEM.INI file, as described in the following procedure. 

~ To add an EMMExclude or VirtualHDirq command to the 
SYSTEM.INI file 

1. Using a text editor, open the SYSTEM.INI file, which is located in 
your Windows directory. 
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2. Find the [386Enh] section of the file, and type one of the following 
lines: 

EMMExclude=AOOO-FFFF 

VirtualHDirq=F ALSE 

3. Save your changes to the SYSTEM.INI file. 

4. Type win to start Windows. 

Note When you add the EMMExclude command to your 
SYSTEM.INI file, you are probably excluding more address space than 
is necessary. To find out a more precise amount of address space to ex
clude, you can use the Microsoft Diagnostics (MSD) program. To start 
MSD, type msd at the MS-DOS prompt. From the first screen, choose 
Memory. You should exclude any address space identified as "RAM" 
or "ROM." You might also be able to exclude address space identified 
as "Possibly Available." 

You need to copy Windows files directly to your computer. 
The files on the Windows Setup disks are compressed and are not 
usable until expanded. Usually, Setup and Windows Control Panel ex
pand the compressed files as they are copied to your hard disk. In some 
cases, you may need to copy files directly from a Windows Setup disk 
without using Setup or Control Panel. 

~ To copy Windows flies to your system and expand them 

1. Copy EXPAND.EXE from Windows Disk 2 to your hard disk. 
(This program expands compressed files to a usable format.) 

2. Insert in drive A (or another floppy disk drive) the disk containing 
the file you want to expand. 

3. Type the following command at the MS-DOS prompt, and then 
press ENTER: 

expand x: V'ilename 1 y: \windirectoryVilename2 

where x is the floppy disk you are copying from,jilenamel is the 
name of the compressed file you want to copy, y is the hard disk you 
are copying to, windirectory is the name of your Windows directory, 
and jilename2 is the file that will appear on your hard disk. 

The compressed file is expanded as it is copied to your hard disk. 
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When files are compressed, their extensions are renamed to end with 
an underscore. System files (.SYS) are named SY_ as compressed files. 
For example, MOUSE.SYS is named MOUSE.SY _, and HIMEM.SYS 
is named HIMEM.SY _. When you use Windows Setup to install these 
files, they are renamed with .SYS extensions. 

If you use the expand command to copy .SY _ files to your hard disk, 
you must change their filename extensions to .SYS. You can use the 
MS-DOS rename command, or you can rename each file as you copy 
it from the Windows Setup disk by using the expand command. For 
more information about the expand command, see your MS-DOS 
documentation. 

Using a Mouse 
The following sections describe solutions to problems you might have 
when using a mouse with Windows. If you cannot use your mouse and 
need to use your keyboard with Windows, see Chapter l, "Windows 
Basics," in the Microsoft Windows User's Guide. 

The mouse won't work with Windows. 
• If you are using a serial mouse, make sure you are using either the 

COMl or COM2 serial port. You cannot use serial port COM3 or 
COM4 with a mouse in Windows. Examine your hardware to see 
which port the mouse cable is attached to. Then make sure Windows 
is set up correctly by choosing the Ports icon in Control Panel. 

• Determine which hardware interrupt the mouse port is set to use and 
whether there is another device set to use the same interrupt. If there 
is an interrupt conflict with the serial or bus port that the mouse is 
connected to, the mouse won't work. For information about chang
ing interrupt settings and determining which interrupts the mouse 
port and other hardware are using, see your mouse and hardware 
documentation. 

The mouse pointer won't move. 
• If the mouse pointer appears on your screen but won't move, choose 

the Windows Setup icon in the Main group to display a list of set
tings. Make sure the mouse you are using is listed here. 
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• If you are certain you are using the appropriate mouse driver, 
and the mouse pointer still won't move, check whether there is an 
interrupt conflict between the mouse port and another device. For 
information about determining which interrupt your mouse or other 
hardware is using, see the documentation supplied with your hard
ware. 

The mouse pointer jumps around on the Windows screen. 
If the mouse pointer jumps around rather than moving smoothly, you 
might have one of the following problems: 

• There might be a system-hardware interrupt conflict. You need to set 
up the mouse so that it isn't using an interrupt that is being used by 
another device. For information about changing mouse interrupt set
tings, see the documentation supplied with your mouse. 

• Your mouse needs to be cleaned. For instructions, see the documen
tation supplied with your mouse. 

The mouse won't work with a non-Windows application 
running in a window. 
If your mouse works with a non-Windows application running in a full 
screen but not with a non-Windows application running in a window, 
you could have one of the following problems: 

• To use a mouse with a non-Windows application that is running in a 
window, you must set up the mouse driver before starting Windows. 
For a Microsoft mouse, you need to use either the MOUSE.SYS or 
MOUSE.COM driver, usually located in your Windows directory. 
Both drivers are provided with Windows. You set up MOUSE.SYS 
in the CONFIG.SYS file, or you set up MOUSE.COM in the 
AUTOEXEC.BAT file. For example, to specify the MOUSE.SYS 
device driver located in the WINDOWS directory on drive C, add 
the following command line to your CONFIG.SYS file: 

device=c: \ windows\mouse.sys 

If you are copying these files from the Windows disks, you need to 
use the expand command. For more information, see "You Need to 
Copy Windows Files Directly to Your Computer" earlier in this 
chapter. 
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• The MS-DOS mouse driver you are using might not support the 
use of a mouse pointer for a non-Windows application running 
in a window. The MS-DOS mouse drivers, MOUSE.SYS and 
MOUSE.COM (provided with Windows version 3.1), do support 
the use of a mouse pointer for a non-Windows application running 
in a window. 

• You might be using a display driver that does not support the use 
of a mouse pointer for a non-Windows application running in a 
window. 

If you are using a 16-color, 800x600-resolution display adapter with 
a display driver that was provided with a Windows version earlier 
than 3.1, you need to update the driver. Display drivers provided 
with the Windows version 3.0 Supplemental Driver Library should 
be updated as well. You need to use the standard Super VGA display 
driver provided with Windows version 3.1. You can install this 
driver, even after Windows is installed, by using the Setup program. 

If you are using a display driver that was provided with your display 
adapter, you might need to update the driver to one designed to work 
with non-Windows applications running in a window. Contact your 
display-adapter manufacturer for an updated display driver. For 
more information about using specific display adapters, view the 
README.WRI file by using Write (in the Accessories group). 

• If you are using an IBM mouse with the IBM mouse driver version 
1.0, you need to replace this driver. Version 1.0 of this driver was 
not designed to support non-Windows applications running in a 
window. Contact your dealer for an updated version of the mouse 
driver. 

Running Applications 
Applications usually run without problems. However, you might 
occasionally receive an error message when starting or running an 
application, or a key or function might not work properly. The follow
ing recommendations cover the most common problems. 
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You press a key, and the unexpected happens. 
If a key combination doesn't work, it is usually because Windows or 
another running application is using the key combination for another 
purpose. 

The following are some common problems and solutions: 

• You use a key combination that should perform a function in an 
application, but it instead performs a Windows function (for 
example, you unexpectedly switch to another application). 

You are probably using a Windows shortcut key. You assign a 
Windows shortcut key to an application by using the Properties com
mand on the File menu in Program Manager or by specifying a key 
combination in the application's program information file (PIF). Use 
the Properties command or check the application's PIF to find out 
whether you have assigned a Windows shortcut key to your applica
tion. For more information, see Chapter 3, "Program Manager," and 
Chapter 7, "Non-Windows Applications," in the Microsoft Windows 
User's Guide. 

• You press a Windows shortcut key, such as ALT+TAB, but the 
Windows function is not performed. 

The key combination probably is reserved for a non-Windows appli
cation and no longer performs the Windows function. Check the PIF 
of the foreground application to determine whether a Windows key 
combination is reserved for that application. 

• If Windows is running in 386 enhanced mode and you hear a beep 
whenever you press a key while using a particular application, 
Windows might have suspended that application. This might hap
pen, for example, if you try to run the application in a window but it 
cannot run in a window. If that is the case, press ALT+ENTER to return 
the application to a full screen. If the application does not respond to 
ALT+ENTER, you might be able to press CTRL+ALT+DEL to quit the 
application without having to restart Windows or your system. 

• If Windows is running in 386 enhanced mode and you have chosen 
the Select or Mark command from the Control menu (the applica
tion's title bar will contain the word "Select" or "Mark"), Windows 
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is waiting for you to select information for transfer onto the Clip
board. To cancel the command, press the ESC key. To copy selected 
information onto the Clipboard, choose the Copy command from the 
application's Edit menu, or press the right mouse button. 

• If Windows is running in 386 enhanced mode and you have chosen 
the Scroll command from the Control menu (the application's title 
bar will contain the word "Scroll"), Windows is waiting for you to 
use the arrow keys to scroll through the information in the applica
tion's window. To cancel the Scroll command, press the ESC key. 

• If you are using a language that has accented characters, you might 
not be able to use those characters when naming files. Before 
MS-DOS reads a filename, it shifts all the letters in the filename to 
uppercase. Some accented characters do not have valid uppercase 
characters. 

Your application stops responding to the system. 
• You can press CTRL+ALT+DEL to quit an application that has stopped 

responding to the system. Windows displays a message confirming 
your action. To continue, follow the instructions in the message. 

When you are using MS-DOS without Windows and you 
press CTRL+ALT+DEL, your computer restarts. When you press 
CTRL+ALT+DEL while using Windows, you can quit the application 
that has stopped responding, without having to restart your computer 
and Windows. 

• You are running an earlier version of a Windows application that is 
incompatible with Windows version 3.0 or later. Contact the manu
facturer for an updated version of the application. 

Your Windows application doesn't work the way it did with 
Windows version 3.0. 
Although most applications designed for Windows version 3.0 work 
with Windows version 3.1, there are a few exceptions. These appli
cations are listed in the Help file APPS.HLP. This file also contains 
information about how to obtain an updated version of your application. 
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~ To open and view the Help file APPS.HLP 

1. From the Help menu in Program Manager, choose Contents. 

Help Contents for Program Manager appears. 

2. From the File menu in Program Manager Help, choose Open. 

The Open dialog box appears. 

3. From the list of files, select the APPS.HLP file. 

The Help file appears. The applications are listed alphabetically in 
the file. 

Your application runs too slowly. 
If your application runs too slowly, try one of the following solutions: 

• Your system might be low on memory. If your hard-disk light blinks 
frequently, Windows is swapping information to disk to make room 
in memory for other information or is rereading information from 
the disk into memory. For information about making more memory 
available, see Chapter 14, "Optimizing Windows," in the Microsoft 
Windows User's Guide. 

• You might need to set up a permanent swap file. If Windows is run
ning in 386 enhanced mode and you run more than one application 
at a time or applications that use very large files, you should set up a 
permanent swap file. Do this by choosing the 386 Enhanced icon in 
Control Panel. When the 386 Enhanced dialog box appears, choose 
the Virtual Memory button. For more information, press the FI 
key while using the dialog box, or see Chapter 14, "Optimizing 
Windows," in the Microsoft Windows User's Guide. 

Your Super VGA screen isn't restored correctly. 
If you use a Super VGA and the screen contents aren't restored 
correctly when you switch between Windows and a non-Windows 
application, you probably need to update your display driver. The 
Super VGA display driver provided with Windows version 3.1 supports 
most 16-color, 800x600-resolution display adapters. If it doesn't work 
correctly, contact the display-adapter manufacturer to find out whether 
there is a Windows version 3.1 display driver available for your display 
adapter. 
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You cannot take a snapshot of the screen. 
If you cannot take a "snapshot" (bitmap) of an application screen, one 
of the following might be the cause: 

• If you are running Windows in standard mode and trying to take a 
snapshot of a non-Windows application, the No Screen Exchange 
check box might be selected in the application's PIF. This option 
prevents you from copying information onto the Clipboard by using 
PRINT SCREEN or the ALT+PRINT SCREEN key combination. This option 
might be set to give the application enough memory to run. Try clear
ing this check box. 

• If you are trying to take a snapshot of a non-Windows application 
by using the PRINT SCREEN or ALT+PRINT SCREEN key combination 
(usually Windows shortcut keys), these combinations might be re
served for the active application. Try clearing the corresponding 
Reserve Shortcut Key check boxes in the active application's PIF. 

• If Windows is rumiing in standard mode, the wrong Video Mode 
option button might be selected in the application's PIF. Try select
ing a higher-resolution video mode. 

• If Windows is running in 386 enhanced mode, more memory might 
be required. Quit some applications to free memory. For more infor
mation, see "Managing Memory" later in this chapter. 

You cannot paste information into a non-Windows 
application. 
If you cannot paste information from the Clipboard into a non
Windows application, one of the following could be the cause: 

• The information might not be in text format. Windows cannot paste 
graphics into a non-Windows application. Try saving the informa
tion you want to paste as a separate file and then opening the file by 
using the non-Windows application. 

• A non-Windows application might not be able to accommodate 
the fastest pasting method. If Windows is running in 386 enhanced 
mode, the Allow Fast Paste check box in the application's PIF is 
usually selected, because most applications can accommodate the 
fastest pasting method. However, if the application cannot use the 
fastest method, it might not respond when you try to paste into it. 
Try clearing the Allow Fast Paste check box in the application's PIP. 
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You cannot change the font size for a non-Windows 
application. 
• If you cannot change the font size for a non-Windows application 

running in a window, it's probably because the application is run
ning in graphics mode. You can change font sizes only when the 
application is running in text mode. With some non-Windows appli
cations, you can choose which mode the application runs in. To find 
out whether your non-Windows application can run in text mode, 
see the documentation included with your application. 

• You might be using a display driver that doesn't provide the capabil
ity of changing fonts for a non-Windows application running in a 
window. If you are using a 16-color, 800x600-resolution video 
graphics adapter (Super VGA), make sure you are using the Super 
VGA display driver provided with Windows version 3.1. This driver 
supports most Super VGA display adapters. If this driver doesn't 
work, contact the display-adapter manufacturer to find out whether 
a Windows version 3.1 display driver is available. 

• If you are using a display driver that doesn't provide the capability 
of changing fonts for a non-Windows application running in a 
window, try including the following line in the [Non WindowsApp] 
section of the SYSTEM.INI file: 

FontChangeEnable = 1 

For more information about modifying the SYSTEM.INI file, view 
the SYSINI.WRI file by using Windows Write (in the Accessories 
group). 

Note This setting does not work for all displays. In some cases, specify
ing this setting causes the mouse pointer to be displayed incorrectly. 

Your system stops responding or quits unexpectedly. 
If Windows or your computer stops responding; the application or 
Windows quits unexpectedly; or your computer restarts unexpectedly, 
one of the following might be the cause: 

• You are running an earlier version of a Windows application that is 
incompatible with Windows version 3.0 or later. Contact the manu
facturer for an updated version of the application. 
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• You are using hardware that is incompatible with Windows. For 
more information about hardware compatibility, see the Hardware 
Compatibility List supplied with Windows, or use Write (in the 
Accessories group) to view the README. WRI file. Sometimes you 
can resolve hardware incompatibility by adjusting settings in your 
SYSTEM.INI file. For more information about SYSTEM.INI, use 
Write to view the SYSINI.WRI file. 

You receive a message that the registration database is 
corrupted. 
If you have problems such as the following, your registration database 
may be corrupted: 

• You try to open or print a file that is associated with an application, 
and you receive a message that the association information is in
complete. 

• While working with linked or embedded objects, you receive a 
message that the server is not registering properly. 

• In File Manager, you choose the Associate command and there are 
no entries in the list of files in the Associate dialog box. 

If your registration database is corrupted, you must delete the registra
tion database and then recreate it. 

~ To restore your registration database 

1. Quit Windows. 

2. Delete the REG.DAT file (located in your Windows directory). 

3. Restart Windows. 

4. Start Registration Info Editor by opening File Manager and then 
selecting the REGEDIT.EXE file (located in your Windows 
directory) . 

5. From the File menu, choose Merge Registration File. 

The Merge Registration dialog box appears. 



Chapter 4 Troubleshooting 71 

6. In the Merge Registration File, select the SETUP.REG file, and then 
choose the OK button. (The SETUP.REG file is located in the 
SYSTEM directory where you set up Windows.) 

7. Search for *.REG files on drive C by using the Search command on 
the File menu in File Manager. 

8. Double-click each .REG file (or select it, and then press ENTER). 

9. Repeat steps 6 through 8 for each drive on your system. 

Note You may need to contact your software manufacturer if problems 
still persist when running a Windows application. 

Linking and Embedding Objects 
The following sections describe solutions to problems you might 
encounter when linking and embedding objects by using Windows 
applications that support object linking and embedding. 

You receive a message that the server is unavailable. 
The server application must be available when you try to create, edit, 
play, or update an object in a destination document. A server applica
tion cannot respond if it is performing some action (such as printing or 
making calculations), if the cursor is in a field waiting for information, 
or if a dialog box is open. 

Use the following guidelines to solve the problem: 

1. Wait a short while to determine whether the server is going to be
come available to respond to your request. If it becomes available, 
the message goes away and your request is processed. 

2. If the server application does not become available, you may be able 
to choose the Cancel button in the dialog box to cancel the request. 

3. If you do not want to or cannot cancel the request, determine which 
server application is unavailable. 

Switch to the server application, and complete or cancel the action 
that is causing the application to be unavailable. 
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You choose an object type from the Insert Object dialog 
box, but the application doesn't open. 
If you choose an object type from the Insert Object dialog box and the 
application doesn't open, it means Windows cannot find the application. 

Use the following checklist to solve the problem: 

• Make sure the application that creates this object type hasn't been 
deleted from the computer. For example, Paintbrush (PBRUSH.EXE) 
needs to be on your computer before you can open a Paintbrush Pic
ture object type. 

• If the application has been moved from the location specified in the 
registration database, make sure the directory containing the applica
tion is included in the path in your AUTOEXEC.BAT file. 

• Try reinstalling the application. 

You get different results each time you use the Paste 
command. 
When you use the Paste command, the contents of the Clipboard are 
either inserted or embedded into the document. The result is determined 
by the type of application you used to create the information on the 
Clipboard. 

If it is a server application, one that can supply objects for object link
ing and embedding, the information may be embedded when you 
choose the Paste command. When the information is embedded, you 
can activate the information or edit it from within the document. 

If the application used to create the information on the Clipboard does 
not support object linking and embedding, the information is simply 
inserted when you choose the Paste command and cannot be edited or 
activated from within the document. 

A linked sound object updates automatically even though it 
is set to update manually. 
When you create a link, you are inserting into the destination docu
ment a reference to the source document that contains the linked object. 
A presentation of the object is placed in the destination document to 



Chapter 4 Troubleshooting 73 

identify the link. Sometimes, depending on the type of linked infor
mation, this image may be the same as the information in the source 
document. The Manual or Automatic Update setting controls when 
this image is updated in the destination document only. 

The Picture option in the Content window of Object 
Packager is unavailable. 
The Picture option in the Content window displays a snapshot view of 
the object. Picture view is available only when the object was created 
with a server application and when the Clipboard is used to transfer the 
object into Object Packager. 

If you use the Import command on the File menu to load a document 
into Object Packager or you copy onto the Clipboard information 
created by using an application that is not a server, the Picture option 
is not available. 

A linked object is not updating. 
Under certain circumstances, a linked object must be manually updated 
before the visual presentation of the linked object in the destination 
document is updated, regardless of whether it is an automatic or manual 
link. This is true for links to documents that contain text, spreadsheets, 
and pictures because these linked objects are represented in the destina
tion document by images that reproduce the information in the source 
file. This is not true for links to sound and animation files because these 
types of links are represented by icons and not the contents of the 
linked document. 

For example, suppose you have a destination document open that 
contains a link to a Paintbrush document, and you have the source 
document open in Paintbrush. When you make changes to the source 
document in Paintbrush, the visual presentation of the Paintbrush object 
in the destination document is not updated with the changes you are 
making. You must save the document in Paintbrush and then update the 
linked object in the destination document to see the updated object. 
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~ To update a link 

1. Select the linked object in the destination document. 

2. From the Edit menu, choose Links. 

The Links dialog box appears. 

3. Choose the Update Now button. 

4. Choose the OK button. 

The Paste command in Cardfile is not available, yet there is 
information on the Clipboard. 
You must first choose the Picture command from the Edit menu before 
you can use the Paste, Paste Link, and Paste Special commands in 
Cardfile. 

A check mark appears next to the Picture command when it is in effect. 

The Paste link command is not available, yet there is 
information on the Clipboard. 
You can only create a link to information in a saved file, so the Paste 
Link command is available in the destination document's application 
only when you copy information from a saved file onto the Clipboard. 

Save the file before copying information onto the Clipboard. Then you 
have the choice of using the Paste command to embed the information 
or the Paste Link command to create a link to it. 

Printing 
The following sections describe common printer problems and offer 
suggestions for correcting the problems. When there are suggested 
steps to follow, you should try to print after you complete one of the 
steps. If you can print from Windows, you've solved the problem. If 
not, try the next step. 
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Your printer does not print. 
When a printer cannot print, the cause is often mechanical. For 
example, the printer could be offline, turned off, or disconnected. 
Use the following checklist: 

• Is the printer plugged in, turned on, and online? 

• Do you have the correct cable for your printer, and is it properly con
nected? For example, if you are using a Hewlett-Packard plotter, you 
need to use a Hewlett-Packard plotter cable. If you suspect the cable 
is the problem, you may want to borrow a cable that is working with 
another computer and printer. 

• Does the currently selected printer in the application you are printing 
from match the printer you are p~inting to? 

• Are the printing options set correctly, and have you chosen the cor
rect port for the selected printer? For more information, see Chapter 
6, "Print Manager," in the Microsoft Windows User's Guide. 

• When you are using a serial printer and you choose the Ports icon in 
Control Panel, does the information in the Settings dialog box match 
those required by your printer? For more information, see Chapter 5, 
"Control Panel," in the Microsoft Windows User's Guide. 

• Do you need to change the ribbon, install a print wheel or cartridge, 
or add paper? Choose the Print Manager icon in the Main group. 
Depending on the printer you are using and the commands you 
have chosen from the Options menu, a message might appear that 
describes the problem. 

• If you are printing to a network printer, have you connected to the 
network printer? 

• Can you print from Notepad and Write? If so, the problem is likely 
with the application you are using. Consult the application's docu
mentation, or contact the software manufacturer. 

• If you are using a switchbox to switch between different printers, try 
clearing the Fast Printing Direct To Port check box in the Connect 
dialog box of the Printer option in Control Panel. (You open the Con
nect dialog box by choosing the Printer icon in Control Panel and 
then choosing the Connect button.) If this doesn't work, try printing 
directly to the printer without using the switchbox. 

If you still cannot print, try copying a small text file from MS-DOS 
directly to the port your printer is connected to. For printers that 
accept ASCII codes (such as dot-matrix printers) and PCL printers 
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(Hewlett-Packard DeskJet, LaserJet, or compatible printer), you could 
type the following at the MS-DOS prompt, specifying the directory 
where your Windows files are located, and the port you are using: 

copy c:\windows\setup.txt Ipt1: 

The output from the copy command (in this case, the contents of your 
SETUP. TXT file) is sent to the printer instead of the screen. If the file 
doesn't print, the problem is not with Windows. For more information, 
see the documentation supplied with your printer. 

For PostScript printers, try copying the file TESTPS.TXT to the port 
you are using. This file was copied to your hard disk when you in
stalled the PostScript printer driver. For example, if your Windows 
system files are stored in a directory named C:\WINDOWS\SYSTEM 
(the default directory name), you would type the following: 

copy c:\windows\system\testps.txt com! 

This command line prints a list of communications settings. Be sure 
your settings match the list. 

You can print from MS-DOS but not from Windows. 
If you can print from MS-DOS but not from Windows, there may not 
be enough space for Windows to store temporary files. (Windows 
creates temporary files when printing, even if you are not using Print 
Manager.) 

~ To see how much space exists for temporary files 

1. At the MS-DOS prompt, type set to see what directory the TEMP 
environment variable is set to use. 

2. If there is no TEMP variable listed, define one. For example, to set 
the TEMP variable to use a directory named TMP located on drive 
C, add the following line to your AUTOEXEC.BAT file: 

set temp=c: \tmp 

You need to restart your computer after making changes to the 
AUTOEXEC.BAT file. Windows uses the root directory of your 
startup drive to store temporary files if there isn't one defined. 
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3. If there is a TEMP variable listed, make sure the specified directory 
exists. If it doesn't exist, you need to create it or reset the value of 
TEMP to specify an existing directory. 

4. Move to the directory specified by the TEMP variable. 

5. Type the dir command to see how much space is available. 
Windows needs at least 2 MB of free disk space in which to store 
temporary files. 

6. If you had to change any of these settings, try printing again. 

If you still cannot print, step through the following checklist: 

• Check the printer cable. Windows applications require that all pin 
connectors are functioning, whereas some non-Windows applica
tions do not. Try using a cable that you know is a working cable. 

• If you are using a serial printer, make sure you do not have an inter
rupt conflict. A mouse might be on the same interrupt as the serial 
port being used for printing. 

• Make sure you are not using a serial port to connect to a network 
printer. Windows supports network-printer connections on parallel 
(LPT) ports only. 

• If you are using a printer that isn't listed during Windows Setup (or 
in the Printers dialog box in Print Manager or Control Panel) and are 
trying to emulate a standard printer, make sure you have chosen the 
correct printer to emulate. See your printer documentation. 

• Try printing without using Print Manager. To turn off Print 
Manager, choose the Printers icon in Control Panel, and then clear 
the Use Print Manager check box. 

• If you are printing to LPTI, try printing to the LPTl.DOS file in
stead. To specify the LPTI.DOS file, choose the Printers icon in 
Control Panel. When the Printers dialog box appears, choose the 
Connect button. Choose LPT I.DOS from the Ports list. If 
LPTI.DOS does not appear in the list, you need to add it to the list 
of ports in the ports section of the WIN.INI file. For more informa
tion, view the WININLWRI file by using Write (in the Accessories 
group). 
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The page prints but is formatted incorrectly. 
If the pages of a document are formatted incorrectly, the margins are in
correct, the document contains extra lines, or the document is paginated 
incorrectly, use this checklist: 

• If you haven't already read the PRINTERS.WRI file provided with 
Windows, you should determine whether it contains information 
specific to your printer. You can view this file by using Write 
(in the Accessories group). 

• Make sure your printer is capable of printing the formats you 
specified in your application. Pay special attention to your printer's 
capabilities when selecting fonts and point sizes. For more informa
tion about the font you specified in Windows, start Write, and then 
choose Fonts from the Character menu. The Font dialog box ap
pears, providing information about the fonts that are available with 
Windows. 

• Make sure you specified the correct settings when you configured 
your printer. When configuring a printer, you can control settings 
such as margin size, number of lines per printed page, paper orienta
tion, and number of dots per inch. Choose the Printers icon in 
Control Panel. In the Printers dialog box, select the printer you 
are using, and then choose the Setup button. 

• If your printer has hardware switches that set page length or 
line length, make sure you've chosen the correct settings. (For 
information, see your printer documentation.) For example, on a 
Hewlett-Packard LaserJet printer, you would set the number of 
lines per printed page to a maximum of 66. 

• If your printer has a hardware switch that inserts an automatic 
linefeed at each carriage return, it should be set for carriage returns 
only. For more information, see your printer documentation. 

• Determine whether the formatting problems are consistent by print
ing the same file twice. If the two printouts look different, you may 
be having problems sending printing information through the port. 
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Your printer output is garbled. 
If you can print your document, but it is unreadable or contains extra 
characters, use this checklist: 

• Make sure the correct printer is selected as the default printer. For 
more information, see Chapter 6, "Print Manager," in the Microsoft 
Windows User's Guide. 

• If your printer accepts font cartridges, make sure you select the cor
rect cartridge when you set the printing options. If the wrong font 
cartridge is selected, the printer may insert stray characters at the 
beginning of lines. For more information, see Chapter 6, "Print 
Manager," in the Microsoft Windows User's Guide. 

• If you have a serial printer, make sure the settings for the printer port 
match those required by your printer. Choose the Ports icon in Con
trol Panel, and then choose the Settings button. Lowering the baud 
rate might solve the problem. 

• You may be using a printer that isn't listed during Windows Setup 
(or in the Printers dialog box in Print Manager or Control Panel). 
If so, you are probably trying to use your printer to emulate a stand
ard printer. Few printers are IOO-percent accurate when emulating 
industry-standard printers. Often, fonts are not printed accurately. 
Try emulating a different type of printer. You could also contact the 
printer manufacturer to find out whether a Windows printer driver 
is available for your printer. 

• The printer buffer may be retaining garbled information. Try turning 
the printer off, waiting a few seconds, and then turning it on again. 

• The printer cable may be faulty. Verify that you have the correct 
cable and that it is functioning. 

As a last resort, try installing the Windows Generic/Text Only printer
driver file to see how it works with your printer. You could also contact 
your printer manufacturer or dealer to determine whether there is a 
problem with your printer. For information about installing printer 
drivers, see Chapter 5, "Control Panel," in the Microsoft Windows 
User's Guide. 
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The fonts on your screen and the fonts that print are 
different. 
A font set is a group of letters, numbers, symbols, and punctuation 
marks with the same design. Screen fonts display information in 
windows and dialog boxes. Printer fonts are part of the printer driver or 
are in the form of cartridge fonts and soft fonts. Many printer drivers, 
cartridge fonts, and soft fonts have matching screen fonts so that the 
fonts on your screen look the same as those you print. If matching fonts 
are not available, Windows uses a font that looks the most like the 
printer font being used. Sometimes there isn't a font that looks the same. 

If you use TrueType fonts, Windows and Windows applications use the 
same fonts, and fonts appear the same on the screen as they do when 
printed. True Type fonts are installed when you set up Windows. 

~ To find out whether TrueType fonts are available 

1. In the Control Panel window, choose the Fonts icon. 

The Fonts dialog box appears. 

2. Choose the True Type button. 

The TrueType dialog box appears. 

3. Note whether the Enable TrueType Fonts check box contains an X. 
If it does, TrueType fonts are available and can be used in your docu
ments. 

To view available fonts, choose the Write icon in the Accessories 
group, and then choose the Fonts command from the Character menu. 
The Font dialog box appears, displaying samples of various fonts. The 
TrueType fonts have a TrueType icon next to them, and printer fonts 
have a printer icon. Plotter and screen fonts have no icon next to them. 

You cannot print TrueType fonts on your laser printer. 
When you are using a laser printer, TrueType fonts are listed in your 
application as a selectable font only if you are using a Windows version 
3.1 printer driver. Windows version 3.1 printer drivers provide the nec
essary information for printing TrueType fonts. If you cannot print 
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TrueType fonts, the printer driver you are using may not be a Windows 
version 3.1 printer driver. Contact your printer manufacturer to find out 
whether a Windows version 3.1 printer driver is available for your 
printer or whether one of the printer drivers supplied with Windows can 
work with your printer. 

Your laser printer does not print your cartridge or soft fonts. 
If you install a font cartridge or soft fonts for your laser printer, but the 
printer doesn't print these fonts, use this checklist: 

• Make sure the printing-option settings for your printer are correct 
and that you have selected the correct cartridge from the Cartridges 
list in the Setup dialog box. (For information, see "Setting the 
Printing Options" in Chapter 6, "Print Manager," in the Microsoft 
Windows User's Guide.) 

• If you are using a font cartridge, make sure it is all the way in its 
slot. (Turn off the printer before checking this.) You may need to 
press firmly on the cartridge until it pops into the slot. 

• If you are using soft fonts, make sure they are properly installed. 
(For information, see the installation kit provided with your soft 
fonts.) 

• If your soft fonts are installed as permanent, perhaps the printer was 
turned off or reset. Try sending the soft fonts to the printer again. 

• You may be using too many soft fonts. Printer drivers can support 
a limited number of soft fonts. Generally, PostScript printer drivers 
have a limit of about 170 soft fonts. PCL printer drivers generally 
have a limit of 250 soft fonts. 

The number of soft fonts you can use is also limited by the maxi
mum size of the WIN .INI file. The WIN .INI file can be no larger 
than 64K. If the file is full, you cannot specify any additional soft 
fonts. One way to minimize the size of the WIN.INI file is to shorten 
the directory paths of the soft fonts. You can do this by moving the 
soft-font files closer to the root of the directory structure and then 
specifying these shorter paths in the WIN .INI file. 

You can also try installing fewer fonts or installing them as tem
porary fonts, if appropriate. For more information, see your printer 
documentation or contact your printer manufacturer. 
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• If you have changed port connections since installing soft fonts, you 
need to reinstall the soft fonts for the new port. If you are using the 
Hewlett-Packard LaserJet and DeskJet family of printers, choose the 
Printers icon in Control Panel, and choose the Setup button in the 
Printers dialog box. Then use the Fonts button in the Print Setup 
dialog box to copy soft fonts from one port to another. 

The printer loses text. 
• If you are using a parallel printer and an LPT port, the cable could be 

faulty. Try using a new cable of the same type. 

If you have a serial printer and it prints the document but loses blocks 
of text, you might have a flow-control (also called handshake) problem 
with your serial port. 

To check for a flow-control problem: 

• Try lowering the baud rate. 

• Make sure all communications settings (baud rate, data bits, 
parity, stop bits, and flow control) are set the same in Windows, in 
MS-DOS, and on the printer. The most common values for these set
tings are 9600 baud, 8 data bits, no parity, 1 stop bit, and XoniXoff 
flow control. 

You can change these settings in Windows by choosing the Ports 
icon in Control Panel and then choosing the Settings button. You 
can also change these settings in MS-DOS by using the mode com
mand. For information about mode command-line options, see your 
MS-DOS documentation. For information about settings on the 
printer, see your printer documentation. 

If the printer is still losing text, make sure all the manual switches 
on your printer are set as described in your printer documentation. 
If you are using a network printer, make sure you are using network 
software that works with Windows. For more information, see the 
NETWORKS.WRI file provided with Windows. You can view this 
file by using Write (in the Accessories group). 
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Only part of a page prints. 
If your printer prints only part of your document, use the following 
checklist: 

• The most common cause of this problem is insufficient memory 
in the printer. It is recommended that you add more memory to the 
printer. If you are printing graphics, try using a lower print resolu
tion. You can try printing a page of text to confirm that you are 
running out of memory because you're printing graphics. 

• Make sure the paper size you chose when configuring the printer 
matches the paper size loaded in the printer. 

• Make sure you have selected the appropriate memory setting in the 
printer-driver dialog box. Make sure you haven't specified more 
memory than your printer actually has. 

To view this dialog box, choose the Printer Setup command in Print 
Manager. 

Paintbrush graphics are too small when printed. 
If you are using Paintbrush and the printed image is much smaller than 
you expected, use the following checklist: 

• From the File menu in Paintbrush, choose Print. Make sure the Use 
Printer Resolution check box is cleared in the Print dialog box. Also, 
check the scaling factor. If a small scaling factor is specified, the 
printer output is small. 

• From the View menu, choose View Picture to see how the image 
appears on the page. You may need to adjust the position. 

• From the Options menu, choose Image Attributes to make changes 
to the width and height of the image. 

Your PostScript printer runs out of memory. 
Occasionally when trying to print a file, you might see a message indi
cating that the printer is out of memory. 

If you are using a PostScript printer and the document you are trying 
to print includes soft fonts, try using TrueType or printer fonts instead. 
(For more information, see Chapter 6, "Print Manager," in the 
Microsoft Windows User's Guide.) 
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You can also try changing some of the options in the Advanced 
Options dialog box. 

~ To change a PostScript printer's options 

1. In the Main group, choose the Print Manager icon. 

2. From the Options menu, choose Printer Setup. 

The Printers dialog box appears. 

3. From the list of installed printers, select the printer you are using. 

4. Choose the Setup button. 

The Setup dialog box appears. 

5. Choose the Options button. 

The Options dialog box appears. 

6. Choose the Advanced button. 

The Advanced Options dialog box appears. 

7. In the Send To Printer As list, make sure Adobe Type 1 is selected. 
This option causes the driver to use outline fonts for large point 
sizes, and bitmaps for small point sizes. 

8. Make sure the Clear Memory Per Page check box is selected. This 
option causes the driver to clear the printer's memory after printing 
each page. 

9. Make sure the Use Substitution Table check box is selected. This 
option causes the driver to use a built-in printer font already in the 
printer's memory instead of using a new font. Make sure you select 
a printer font to use in place of the TrueType fonts in your docu
ment. To do this, choose the Edit Substitution Table button, and then 
supply the necessary information in the Substitution dialog box. 

If you need help working with the Advanced Options or the Substitu
tion dialog box, choose the Help button or press FI while using the 
dialog box. 
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If a problem still exists after completing this procedure, consider 
adding more memory to your printer. If your printer still runs out of 
memory when printing, there is a problem with the driver or printer. 
For more information, contact your printer manufacturer. 

You receive a message that the printer is not responding. 
When printing files, you may receive the following message from Print 
Manager: "The printer on LPT1 is not responding. Check the printer or 
increase the Transmission Retry value in the Printer Connect dialog 
box, and then resume the print queue." 

You might receive this message if you are using PostScript printer 
cartridges; it is most common when printing graphics with these 
cartridges. When the printing process takes too long, it appears to 
Windows that a printer is not responding. If you receive this message, 
go through the following procedure to change the Transmission Retry 
setting (and increase the value, in seconds). 

~ To change the Transmission Retry setting 

1. In the Main group, choose the Print Manager icon. 

2. From the Options menu, choose Printer Setup. 

The Printers dialog box appears. 

3. Select the printer you are using. 

4. Choose the Connect button. 

The Connect dialog box appears. 

5. In the Transmission Retry box, type a larger value (start by doubling 
the current value). 

Managing Memory 
The following sections describe solutions to problems you encounter 
when managing memory in Windows. For more information about 
managing memory, see Chapter 14, "Optimizing Windows," in the 
Microsoft Windows User's Guide. 
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You receive an out-of-memory message. 
If you receive an out-of-memory message when you try to start an 
application, you can free memory in a number of ways, including the 
following: 

• Free some memory before starting Windows. You may be able to do 
this by modifying your CONFIG.SYS and AUTOEXEC.BAT files 
to eliminate any memory-resident software that isn't needed by all 
applications. For information about how to do this, see Chapter 14, 
"Optimizing Windows," in the Microsoft Windows User's Guide. 

• Close any applications you aren't using. 

• Run non-Windows applications in a full screen instead of a window 
(386 enhanced mode only). If a non-Windows application is running 
in a window, you can switch it to a full screen by pressing 
ALT+ENTER while it is the active application. 

• Reduce Windows applications to icons. Many applications use less 
memory when minimized than when running in a window. To re
duce an application to an icon, click the Minimize button in the 
upper-right corner of the window. Or bring the application to the 
foreground, press ALT +SPACEBAR to open the Control menu, and 
choose Minimize. 

• Clear or save the Clipboard contents. For information about using 
the Clipboard, see Chapter 2, "Application Basics," in the Microsoft 
Windows User's Guide. 

• If you are using a desktop wallpaper, set the desktop wallpaper to 
None or use a pattern (a pattern uses less memory than wallpaper). 
For more information, see Chapter 5, "Control Panel," in the 
Microsoft Windows User's Guide. 

• If you are trying to run a non-Windows application, change its PIF 
options. Descriptions of PIF Editor options follow this section. For 
more information about PIF options, see Chapter 8, "PIF Editor," in 
the Microsoft Windows User's Guide. 

• If you are trying to run more than one non-Windows application at a 
time (in 386 enhanced mode), use PIF Editor to change the multi
tasking options, Background Priority and Foreground Priority. For 
more information about these options, see Chapter 8, "PIF Editor," 
in the Microsoft Windows User's Guide. 

• If Windows is running in 386 enhanced mode, set the PIF for each 
non-Windows application so that the application does not run when 
it is in the background. When the Execution Background setting is 
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not selected, the non-Windows application does not run when it is in 
the background. This may temporarily free up memory. 

• Make sure Windows has enough available hard-disk space to create 
and use swap files. For information about how Windows uses swap 
files, see Chapter 14, "Optimizing Windows," in the Microsoft 
Windows User's Guide. 

• If possible, set up a permanent swap file. If Windows is running in 
386 enhanced mode, you can do this by choosing the 386 Enhanced 
icon in Control Panel and then choosing the Virtual Memory option 
button when the dialog box appears. For help working with this 
dialog box, press PI or see Chapter 14, "Optimizing Windows," in 
the Microsoft Windows User's Guide. 

Freeing Memory by Using PIF Editor: Standard Mode If Windows 
is running in standard mode and you receive an out-of-memory 
message when trying to run a non-Windows application, first try the 
techniques listed in the preceding section. If you still get an out-of
memory message, consider changing the following PIF options. Choose 
the PIF Editor icon in the Main group to open PIF Editor. (If you up
graded from Windows version 3.0, PIF Editor remains in the 
Accessories group.) 

Option 

Video Mode 

Memory Requirements 

Suggested change 

Under Video Mode, select the Text option 
button to reduce the amount of memory 
Windows sets aside to display the application. 
This makes more memory available to the 
application. However, if you change modes 
while using the application, you might not be 
able to switch from the application. 

If Windows displays an out-of-memory 
message when you try to start the application, 
reduce the amount specified in the Memory 
Requirements: KB Required box. 

If the application starts but subsequently dis
plays an out-of-memory message, you might 
need to free more memory before starting 
Windows. For information, see Chapter 14, 
"Optimizing Windows," in the Microsoft 
Windows Users Guide. 
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Option 

XMS Memory 

No Screen Exchange 

Prevent Program Switch 

Suggested change 

If the application does not need extended 
memory, make sure that XMS Memory: KB 
Required and XMS Memory: KB Limit are 
set to O. This prevents the application from 
taking up memory that another application 
could use. 

Select this check box to prevent Windows 
from allocating memory when you copy infor
mation onto the Clipboard by using PRINT 
SCREEN or ALT+PRINT SCREEN. This makes 
more memory available to the application. 
However, you cannot take a "snapshot" 
(bitmap) of the non-Windows application 
screen. 

Select this option to make more memory avail
able to the application. Windows makes more 
memory available by preventing you from 
switching from the application. When this 
option is selected, you have to quit the appli
cation to return to Windows. 

Freeing Memory by Using PIF Editor: 386 Enhanced Mode 
When Windows is running in 386 enhanced mode, Windows applica
tions and non-Windows applications share memory resources. The 
more memory that is allocated to one application, the less memory 
there is available to others. If you receive an out-of-memory message 
when trying to start an application, first try the techniques described 
earlier in the "You Receive an Out-of-Memory Message" section. 

If you still receive an out-of-memory message, try changing the PIF for 
the non-Windows application. You can free memory for an application 
by changing the following PIF settings. Choose the PIF Editor icon in 
the Main group to open PIF Editor. (If you upgraded from Windows 
version 3.0, PIF Editor remains in the Accessories group.) 
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Video Memory 

Memory Requirements 

Display Usage 

Execution 
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Suggested change 

Under Video Memory, select the Text option 
button if you plan to use only text mode while 
running the application. Text mode requires less 
memory than graphics mode. Clear the Retain 
Video Memory check box in the Advanced 
Options dialog box to free memory. 

If Windows displays an out-of-memory 
message when you try to start the application, 
reduce the amount specified in the KB 
Required box. 

If the application starts but subsequently dis
plays an out-of-memory message, increase the 
amount specified in the KB Required and KB 
Desired boxes. (An application might also run 
out of memory if it doesn't have enough ex
tended or expanded memory. If you suspect this 
is the case, try increasing the amounts in the 
XMS Memory and EMS Memory boxes.) 

Select the Full Screen option button instead of 
Windowed. Running an application in a 
window requires more memory. 

Select the Exclusive check box to suspend 
other applications while this application is in 
the foreground. This might make more memory 
available to the application, but it prevents 
other applications from running in the back
ground. 

If you still receive an out-of-memory message after changing the 
application's PIF, try changing the PIFs for other applications you 
plan to mn at the same time. 

You can free additional memory for a non-Windows application by 
changing the PIF settings for other applications, as described in the 
table on the following page. 
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Option 

Memory Requirements 

Display Usage 

Execution 

Lock Application Memory 

Suggested change 

Reduce the amount specified in each appli
cation's KB Desired box. (Do not reduce it 
so much that other applications cannot run 
effectively.) 

Select each application's Full Screen option 
button. 

Clear other applications' Background check 
boxes to prevent them from running in the 
background. This makes more memory 
available to the application you want to run 
but prevents the other applications from 
running at the same time. 

You might want to do this to prevent 
particular applications from running in the 
background. If you want to prevent all appli
cations from running in the background, it 
is easier to select the foreground applica
tion's Exclusive check box. 

Clear each application's Lock check box 
(Lock Application Memory, XMS Memory: 
Locked, and EMS Memory: Locked) to free 
memory. This might make more memory 
available to the application you want to run 
but also might slow down the applications 
for which you clear the Lock check box. 

For more information about freeing memory, see Chapter 14, 
"Optimizing Windows," in the Microsoft Windows User's Guide. 

Using Serial Communications 
With Windows, you can have serial communications on serial ports 
COM1 through COM4. The following sections describe solutions to 
problems you might have when using serial communications. 

You cannot access a serial port. 
If Terminal or another Windows communications application cannot 
access a modem or other device connected to a serial port, use the fol
lowing checklist to determine the problem .. 
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• Determine whether another application is preventing access to the 
port even though it is not actively using it. If so, close the application 
so that other applications can access the serial port. For more infor
mation about how non-Windows applications compete for serial 
devices (device contention), see Chapter 7, "Non-Windows 
Applications," in the Microsoft Windows User's Guide. 

• Make sure Windows is using correct base port address and hardware 
interrupt (IRQ) settings for the serial port you are trying to use. For 
instructions on how to specify these settings, see Chapter 5, "Control 
Panel," in the Microsoft Windows User's Guide. 

The computer locks up when you try to access a serial port. 
When a serial device attempts to use a hardware interrupt (IRQ) or 
memory address that is being used by another device, your computer 
can lock up. If you encounter this problem, determine whether one of 
the following is the cause: 

• Serial ports COM1 and COM3 are often set to use interrupt IRQ4, 
and serial ports COM2 and COM4 are often set to use interrupt 
IRQ3. If you are using these ports and your computer locks up, try 
including the following setting in the [386Enh] section of the 
SYSTEM.INI file: 

COMlrqSharing = true 

Note This setting works only for some systems. Many serial 
communications adapters do not allow these ports to be used 
simultaneously, regardless of the setting in the SYSTEM.INI file. 

• Some 85141 A display adapters and some network adapters conflict 
because they use the common address for serial port COM4 (2E8). 
If you are using either of these two devices, determine whether they 
are conflicting with your serial port. 

For information about which interrupts your device uses and how 
to change interrupt settings, see the documentation supplied with the 
device. For more information about specifying interrupt and address 
settings for your serial devices and ports in Windows, see Chapter 5, 
"Control Panel," in the Microsoft Windows User's Guide. 
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Errors occur during high-speed communications. 
The fastest communications speed possible in Windows is dependent 
on many factors, including your serial device, computer speed, com
munications software, and other programs (or applications) running 
on your system. If you have problems during communications trans
missions at high speeds (9600 baud and higher), use the following 
checklist: 

• Close or adjust the background-execution priority for any non
Windows applications running in the background. Such an 
application could prevent the active communications application 
from receiving information fast enough. For information about 
adjusting settings for non-Windows applications, see Chapter 7, 
"Non-Windows Applications," in the Microsoft Windows User's 
Guide. 

• Make sure the computer is running at its fastest possible speed. 
Some computers may run at slower speeds to prolong battery life. 
See the documentation supplied with your computer. 

• Use a serial port that contains a 16550A Universal Asynchronous 
Receiver Transmitter chip (UART). Windows uses the buffering 
capabilities of such ports so that Windows communications applica
tions can achieve high speeds even on slow computers. For more 
information, see your serial-port documentation. 

Note Using the buffering capabilities of Windows causes problems 
with some versions of the UART. In this case, you need to disable 
the buffer of the U AR T by using the cornxfifo setting in the 
SYSTEM.INI file. For more information about this setting, view 
the SYSINI.WRI file by using Write (in the Accessories group). 

Errors occur when you use non-Windows communications 
applications. 
If you are running a non-Windows application that uses the Xon/Xoff 
protocol for serial-port communications, you might lose characters or 
receive protection violations when other running applications are 
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slowing down the system. If this happens, include the following 
setting in your SYSTEM.INI file: 

COMxProtocoi = XOFF 

where x is the number of the COM port. For information about this set
ting and how to change it, view the SYSINI.WRI file by using Write 
(in the Accessories group). 

Using Terminal 
If you have trouble using Terminal and a modem to connect to a remote 
computer, a number of factors could be the cause. The following sec
tions describe solutions for a few common problems. 

The modem does not dial the number. 
Your hardware may be connected improperly, or the incorrect COM 
port is specified. Use this checklist: 

• Make sure the correct cables are attached to the modem and phone 
jack, and between the two computers. 

• Make sure the proper COM port is specified in the Communications 
dialog box. Choose the Communications command from the Settings 
menu in Terminal to see how the Connector option is set. 

You cannot establish a connection. 
If the modem dials and you get an answer, but no connection is estab
lished, you might not have the correct settings for the remote computer. 
Communicating systems must use the same baud rate, although some 
modems can drop back to the rate of the remote modem and signal 
Terminal of the change. (For information about this feature, see your 
hardware documentation.) If you want to transfer data, both systems 
must also use the same settings for data bits, parity type (none, odd, 
even, mark, and space), stop bits, and flow control. 



94 Getting Started with Microsoft Windows 

If you do not know what settings the remote system is using, refer to 
its documentation by calling the remote system's information number 
(not the data-transmission number). Request the information, and 
then set Terminal to match the remote-system settings by using the 
Communications command on the Settings menu. 

You cannot send or receive a text file. 
Communicating systems must use the same handshake (or flow
control) method. 

To determine whether the systems use the same handshake method, 
you need to know the following information: 

• What software-handshake method, if any, the remote system uses. 

The standard method is XoniXoff. However, another method may 
be used. 

• Whether the remote system is using the hardware-handshake method. 

If it is, choose the Communications command from the Settings 
menu in Terminal, and then select the Hardware option button. 

Using Windows with a Network 
The following sections provide solutions for problems you might 
encounter when running Windows with a network. Be sure to also 
read the NETWORKS.WRI file; you can do so by using Write in the 
Accessories group. 

You cannot connect to a network drive. 
• If you cannot connect to a network drive or network printer from 

Windows, try making the network connection before starting 
Windows. If you cannot, it is probably not a Windows problem. 

• If you cannot connect to a network, make sure you are using the cor
rect network drivers. You can find out what network driver you are 
using by choosing the Windows Setup icon in the Main group. 
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You have trouble when running a shared copy of Windows. 
• If you receive a message about sharing violations while running a 

shared copy of Windows or a shared copy of another application, 
make sure the application's file attributes are set to read-only. You 
can view or change a file's attributes by using the Properties com
mand on the File menu in File Manager. 

• If you have trouble running a shared copy of Windows, make sure 
your personal Windows directory and the shared Windows directory 
are both specified in your path. Your personal Windows directory 
must be specified first. 

• Make sure you are using the same letter to designate the network 
drive every time you connect to that drive. For example, if you use 
the drive letter W when you connect to the network drive to set up a 
shared copy of Windows, Windows records W as the path it should 
use in the future to look for the shared Windows files. If the next 
time you connect to the same network drive you use a letter other 
than W, you will not be able to start Windows correctly. 

If you do need to specify a different drive letter when you connect 
to a network drive in order to use a shared application, be sure to 
change the path that Windows uses to find the application. 

You have trouble with network software when running 
Windows. 
• If you cannot run Windows or other applications while your network 

software is loaded into the high memory area (HMA), the first 64K 
of extended memory, try disabling the network software's HMA 
options. For more information, see the documentation provided with 
the network software. 

• If you cannot run Windows while your network software is loaded 
into the upper memory area between 640K and I MB, try loading 
the network software into conventional memory. Some network 
software does not work when loaded into the upper memory area. 

• If your system locks up when you receive a network pop-up 
message, you might need to either disable such messages or run a 
Windows application that properly displays them. For example, 
WinPopup is such an application and is supplied with Windows. 
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Using Two Versions of Windows 
The following list describes solutions for problems you might en
counter when you have two versions of Windows installed on your 
computer: 

• Make sure the path command in your AUTOEXEC.BAT file speci
fies the directory that contains the version of Windows that you are 
currently using. Remove the directory of the older version from the 
path command before you install the newer version. You can check 
the dates of files by using the All File Details command on the View 
menu in File Manager. 

• When you want to run an application, print a file, install a printer, or 
install a driver, make sure the current directory is the directory that 
contains the version of Windows that you are currently using. 
Windows searches the current directory for the application's files 
before searching other directories specified by the path command. 

• Always use the device drivers for the version of Windows that you 
are currently using. 

• If you want to use applications that are set up in the same directory 
as the earlier version of Windows (not a subdirectory of it), you 
probably need to set up those applications in the directory where the 
later version of Windows is located. In some cases, you can simply 
copy the files to the new directory; in other cases, you must set up 
the application again. 

• If you set up an application in Windows version 3.0 and you want to 
run the application in Windows version 3.1, you need to set up the 
application again from version 3.1. 

Before You Contact Product Support 
Services 
If you still have difficulties with Windows and are considering con
tacting Microsoft Product Support Services (PSS), you should read the 
following guidelines. 
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Read the Windows text files. 
During Windows Setup, several text files are copied to your hard 
disk. The filenames end with the . WRI extension and are placed in 
the directory where you set up your Windows files. The files contain 
information that was received too late to be printed in the Microsoft 
Windows User's Guide. They also contain information about the initiali
zation files, SYSTEM.INI and WIN.INI. Take a look at these files 
before contacting Product Support Services. 

~ To open and read the README.WRI file 

• In the Main group, choose the Read Me icon. 

Write starts and opens the README.WRI file. This file contains 
information about locating and opening other Windows text files. 
For information about using Write, press the FI key, or choose 
Contents from the Help menu. 

If you chose not to install the initialization files when you set up 
Windows, you can run the Windows Setup program again to install 
them now. For more information about using the Setup program, see 
Chapter 1, "Setting Up Windows." 

Know your system. 
When you contact Product Support Services, the technician needs to 
know whether there is anything unique about your computer system. To 
help the technician, you should know the following about your system 
before you contact PSS: 

• The contents of your CONFIG.SYS and AUTOEXEC.BAT files. 
(For more information about the role these files play in troubleshoot
ing, see the following section, "Streamline the CONFIG.SYS and 
AUTOEXEC.BAT Files.") 

• The drive and directory where Windows is installed. 

• The type (brand and processor) of computer you are using 
(for example, Compaq 80386). 
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• The version and type of BIOS (basic input/output system) in your 
computer. 

• The amount of RAM (random access memory) your computer has. 

• The size of your hard disk. 

• The type of display adapter you are using (for example, EGA or 
VGA). 

• The type of mouse you are using (brand, model, and whether it is 
serial or bus). 

• The type and layout of the keyboard you have (for example, 
enhanced). 

• If you are running Windows on a network; and if so, the name and 
version number of the network software you are using. 

• The printer and printer port you are using. 

• The amount of memory your printer has. 

• The names and version numbers of applications you are running 
with Windows. 

It may also be helpful if you know the type of hard-disk controller in 
your computer. 

Microsoft Diagnostics If you are uncertain about your computer 
configuration, you can use the Microsoft Diagnostics (MSD) program 
before contacting PSS. The PSS technician asks questions that you can 
answer with the information supplied by MSD. This program is pro
vided with Windows. During Windows setup, this file is placed in 
your Windows directory. 

~ To start Microsoft Diagnostics 

• Type the following at the MS-DOS prompt, and then press ENTER: 

msd 
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Streamline the CONFIG.SYS and AUTOEXEC.BAT files. 
If you want to troubleshoot a problem yourself, it's best to start with 
a "minimum" Windows configuration. This means that as a test, you 
should try removing unused applications, memory-resident programs 
(TSRs), and unnecessary device drivers from your CONFIG.SYS and 
AUTOEXEC.BAT files. You can use a text editor, such as Notepad 
(in the Accessories group), to open and edit these files. When just a 
few applications are running with Windows, it's easier to isolate your 
problem. 

Before you make any changes, create a system disk that includes a 
backup copy of both the CONFIG.SYS file and the AUTOEXEC.BAT 
file. You can restore these files when you are finished with the trouble
shooting tests. You also can use the floppy disk to start your system, if 
necessary. 

You can make a system disk by starting File Manager (in the Main 
group), and then choosing Make System Disk from the Disk menu. 
Then copy your current CONFIG.SYS and AUTOEXEC.BAT files to 
the disk. These files are usually located in the root directory of your 
first hard disk drive, which is usually drive C. If you start your system 
by using a floppy disk, these files are located in the root directory of 
that disk. 

When removing command lines from your CONFIG.SYS and 
AUTOEXEC.BAT files, make one change at a time. After making 
one change, test it. This will help you isolate the problem. As a general 
rule, if you don't know what a particular command line does in the 
CONFIG.SYS or AUTOEXEC.BAT file, do not remove it. If you are 
using disk-partitioning software, such as DMDRVR.BIN, do not re
move the command lines that specify it. 

On the following page are examples of CONFIG.SYS and 
AUTOEXEC.BAT files at a minimum configuration. 
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A streamlined CONFIG.SYS file: 

fil es=30 
buffers=20 
device=c:\windows\himem.sys 

The files command sets the number of files MS-DOS can access at one 
time. The buffers command allocates memory for buffers when your 
system starts. The device command in this example sets up the 
HIMEM.SYS device driver. 

A streamlined AUTOEXEC.BAT file: 

prompt $p$g 
path c:\;c:\windows;c:\msdos 
set temp=c:\windows\temp 

The prompt command determines the appearance of the command 
prompt. The path command specifies the search path for MS-DOS 
and Windows. (Some versions of MS-DOS might name this directory 
something other than \MSDOS.) The set temp command specifies the 
directory where temporary files are stored. You may need to create the 
specified directory if it does not exist. The directory for temporary 
swap files should be a location that has at least 2 MB of available disk 
space. For more information about temporary swap files, see Chapter 
14, "Optimizing Windows," in the Microsoft Windows User's Guide. 

If, after reading these sections, you are still having trouble with 
Windows, you can call PSS. Since the technicians ask questions about 
your computer configuration and the contents of specific files, you 
should be at your computer when you place the call. 

Microsoft Product Support Services 
Microsoft offers a variety of support options to help you get the most 
from your Microsoft product. The following information summarizes 
these options. 

If you have a question about your Microsoft product, first look in the 
product documentation or consult online Help. If you cannot find the 
answer, contact Microsoft Product Support Services. 

Outside the United States, contact Microsoft Product Support Services 
at the Microsoft subsidiary office that serves your area. For information 
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about Microsoft subsidiary offices, see the following section, "Product 
Support Worldwide." For information about additional support options, 
you can refer to a card enclosed in your Microsoft Windows package. 

Getting Product Support in the United States 
The following means of support are available in the United States. 
These services are provided using the English language. 

• Call the Interactive Voice Support Service 

You can hear recorded responses to common Microsoft Windows 
questions and order application notes by fax. This automated 
service is always available and requires a touch-tone telephone. 
For assistance with Microsoft Windows, dial (206) 635-7245. 

You can use the following keys on your touch-tone telephone after 
you reach the Interactive Voice Support Service: 

• To advance to the next message, press *. 

• To repeat the current message, press 7. 

• To return to the beginning of the Interactive Voice Support 
Service, press #. 

• Call Microsoft Product Support Staff 

Call (206) 637-7098 Monday through Friday, between 6:00 A.M. and 
6:00 P.M. Pacific time. 

When you call, you should be at your computer and have the 
Microsoft Windows documentation at hand. Be prepared to give the 
following information: 

• Your product's serial number. Your serial number label is on the 
inside back cover of this book. 

• The version numbers of Windows and MS-DOS that you are 
using. 

• The type of hardware you are using. 

• The exact wording of any messages that appeared on your screen. 

• What happened and what you were doing when the problem 
occurred. 

• How you tried to solve the problem. 

Microsoft's support services are subject to Microsoft's prices, terms, 
and conditions in place at the time the service is used. 
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Product Support Worldwide 
Microsoft provides product support services throughout the world. To 
receive product support or for information on how to receive product 
support, contact the Microsoft subsidiary office that serves your 
country. Microsoft subsidiary offices and the countries they serve 
are listed in the following table. 

For this country 

Australia 

Austria 

Argentina 

Baltic republics 

Belgium 

Bermuda 

Bolivia 

Brazil 

Canada 
Caribbean countries 

Central America 

Chile 

Commonwealth of 
Independent States 

Colombia 

Denmark 

Eastern Europe 

Ecuador 

England 

Finland 

Contact this office 

Australia 

Austria 

Argentina 

Germany 

Belgium 

Venezuela 

Argentina 

Brazil 

Canada 
Venezuela 

Venezuela 

Argentina 

Germany 

Venezuela 

Sweden 

Germany 

Venezuela 

United Kingdom 

Sweden 

Using this number 

(02) 870-2131 

0660/65-10 

(54-1) 814-0356 

(0049) 089/3176-1110 

02-5133274 (Dutch) 

02-5023432 (English) 

02-5132268 (French) 

0058.2.914739 

(54-1) 814-0356 

011-533-2922 

1 (416) 568-3503 

0058.2.914739 

0058.2.914739 

(54-1) 814-0356 

(0049) 089/3176-111 0 

0058.2.914739 

(46) (8) 752 68 50 
(applications) 
(46) (8) 752 6050 
(systems) 

(0049) 089/3176-1110 

0058.2.914739 

(734) 271000 

(46) (8) 752 68 50 
(applications) 

(46) (8) 752 6050 
(systems) 
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For this country Contact this office Using this number 

France France (33)(1)69-86-10-20 

French Polynesia France (33)(1)69-86-10-20 

Germany Germany (0049) 089/3176-1110 

Iceland Sweden (46) (8) 752 6850 
(applications) 

(46) (8) 752 60 50 
(systems) 

Italy Italy (39) (02) 26901363 
(applications) 

(39) (02) 26901354 
(SDK) 

Japan Japan (81)(3)3363-0160, 
3363-0170 

Korea Korea (82) (2) 563-9230 

Liechtenstein Switzerland (0041) 1/ 342-4085 
(German) 

(0041) 22/7389688 
(French) 

Luxembourg Netherlands (0031) 2503-77877 
(Dutch) 

(0031) 2503-77853 
(English) 

Mexico Mexico (52) (5) 325-0912 

Netherlands Netherlands 02503-77877 (Dutch) 

02503-77853 (English) 

New Zealand Australia (02) 870-2131 

Northern Ireland United Kingdom (734) 271000 

Norway Norway (47) (2) 18 35 00 

Papua New Guinea Australia (02) 870-2131 

Paraguay Argentina (54-1) 814-0356 

Peru Argentina (54-1) 814-0356 

Portugal Portugal 351 14412205 

Puerto Rico Venezuela 0058.2.914739 

Republic of Ireland United Kingdom (734) 271000 

Scotland United Kingdom (734) 271000 

Spain Spain (91) 803 9960 
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For this country 

Sweden 

Switzerland 

Uruguay 

Venezuela 

Wales 

Contact this office 

Sweden 

Switzerland 

Argentina 

Venezuela 

United Kingdom 

Using this number 

(46) (8) 752 68 50 
(applications) 

(46) (8) 752 60 50 
(systems) 

1/ 342-4085 (German) 

(41-22) 738 96 88 
(French) 

(54-1) 814-0356 

0058.2.914739 

(734) 271000 

Note For product-support information for countries not listed, contact 
the United States office at (206) 936-8661. 
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